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FOREWORD
ICLEI ACCCRN Process

We, at ICLEI-Local Governments for Sustainability, constantly strive to work with and for cities to 
help them better respond to challenges they do, or could, face. In this endeavour, for over 20 years 
now, we have developed tools and processes specifically for local governments around the world. 
Given our in-depth understanding of the needs of cities in different regions and how they function, 
we have been able to successfully design processes and procedures that are most relevant and 
appropriate for them. The ICLEI ACCCRN Process (IAP) is another such resource that is helping 
several cities in South and Southeast Asia in building resilience to climate change.

Climate change is a global and local challenge with events such as increased precipitation, heat 
stress, and floods increasingly disrupting existing infrastructure and systems within cities. There 
is a growing awareness amongst cities around the world that while negotiations are held, and 
decisions, plans and protocols are debated and designed at the national and international levels, 
local governments themselves need to initiate responsive actions. Several cities are standing up 
to this challenge and working towards protecting their communities and assets against climate 
threats. The ICLEI ACCCRN Process is a tested resource that will help them in this endeavour. 

Building urban climate change resilience has to intrinsically be an inclusive and participatory effort 
that brings together a variety of stakeholders, influences political will and promotes collective 
action. As the level of government closest to the people, local governments are best positioned to 
be the integrating force that creates synergistic links and such mutually beneficial partnerships. 

As a phased process supported by tools, the IAP aims at stimulating collective learning and action 
at the local level. It requires local governments to take ownership of the process and to actively 
include all relevant stakeholders in the process of climate resilience building. It provides simple 
yet rigourous steps that can be largely implemented by the cities themselves, with expert inputs 
required at specific points. 

We are grateful for the support provided by the Rockefeller Foundation under its Asian Cities 
Climate Change Resilience Network program that enabled us to develop and disseminate this 
toolkit.

We hope that the ICLEI ACCCRN Process will concretely contribute to the climate resilience 
building efforts of cities in the Asian region and beyond.

Emani Kumar
Deputy Secretary General, ICLEI-Local Governments for Sustainability
Executive Director, ICLEI-Local Governments for Sustainability – South Asia 
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The Rockefeller Foundation is proud to have collaborated with ICLEI to develop what we believe is 
a unique resource for cities to draw on as they think about the uncertainties, shocks, and stresses 
with which they need contend. The ICLEI ACCCRN Process (IAP) is derived from the practical 
experience from a group of pioneering cities across Asia, and will serve as a timely asset for 
the growing number of cities that recognize the urgency of investing in building their resilience 
to the impacts of climate change and urbanization. The Rockefeller Foundation defines urban 
climate change resilience (UCCR) as the capacity of cities (individuals, communities, institutions, 
businesses and systems) to survive, adapt, and thrive in the face of climate related stresses and 
shocks, and even transform when conditions require it.  Building UCCR is a complex journey that 
requires effective leadership, strong partnerships, inclusive processes, and an ability to translate 
diverse technical data and information into practical action. This is precisely what the IAP offers.

The IAP provides step-by-step guidance in a user-friendly format, but its real value is in offering 
flexible ways to build on knowledge and processes that already exist. With thousands of cities 
needing to start their resilience building journey—each with unique political, social, and economic 
characteristics—a linear and prescriptive tool would be of limited value. This guide encourages 
iterative learning and review to maximize relevance, ownership, and engagement for the range of 
actors in a city. Indeed, ICLEI’s process for developing the IAP has modeled these very qualities. 
This is a cumulative product from three year years of piloting, review, and refinement involving 
multiple cities and a number of expert perspectives. From across the Asian Cities Climate Change 
Resilience Network (ACCCRN) alone, a number of partners have been directly implementing UCCR 
planning efforts in cities that have informed the work of ICLEI. These include the Arup International 
Development, Challenge to Change, the Gorakhpur Environmental Action Group (GEAG) in India, 
the Institute for Social and Environmental Transition (ISET), Mercy Corps Indonesia, the National 
Institute for Science and Technology Policy and Strategy Studies (NISTPASS) in Vietnam, TARU 
Leading Edge in India, and the Thailand Environment Institute (TEI). 

With huge uncertainties remaining about future climate scenarios –given the lack of global action 
to date –and with so much urban development and expansion yet to come, we need to recognize 
how nascent the field of UCCR is.  As such, we believe that this guide will need to continue to evolve 
as we learn from its application in an expanding set of cities. We congratulate ICLEI and its team on 
this vital contribution to making cities – including the poor and vulnerable populations that inhabit 
them– more resilient. 

Ashvin Dayal
Associate Vice President and Managing Director, Asia
The Rockefeller Foundation 



INTRODUCTION
ICLEI ACCCRN Process

Cities as centres of economic activities cater to half of the world’s population – and this share 
is growing. Not only as centres of growth but also as major consumers of resources, urban areas 
are one of the major emitters of greenhouse gases. In addition, these global emissions are leading 
to climate change and variability causing adverse impacts at the local level in terms of disruptions 
and damages to physical, social, economic, and environmental systems. Cities are therefore 
both the cause and the victims of climate change.

The ICLEI ACCCRN Process (IAP) has been developed by ICLEI - Local Governments for 
Sustainability’s South Asia and Oceania offices through involvement with the Rockefeller 
Foundation supported Asian Cities Climate Change Resilient Network (ACCCRN) program. It 
enables local governments to assess their climate risks in the context of urbanisation, poverty and 
vulnerability and formulate corresponding resilience strategies.

The IAP toolkit draws on the experience from the ten core ACCCRN cities (see www.acccrn.org) 
and supplements this with learning, models, approaches and best practices of existing ICLEI 
approaches. The toolkit was tested in three Indian cities – Shimla, Bhubaneswar and Mysore - and 
subsequently used in a range of cities in Indonesia, Bangladesh, the Philippines and India.

With a strong city focus, this toolkit is targeted at city governments and their role in 
catalysing community building. It provides a streamlined process that is simple and yet rigorous, 
and which can be implemented by the cities themselves, with only minimal need for external 
support. It enables local governments to assess their climate risks, formulate and implement 
corresponding resilience strategies. The vision is to build resilience to climate change across all 
urban systems and groups, in particular the poorest and most marginalised.

The ICLEI ACCCRN Process has been designed in a step-by-step format, divided into 6 phases.  
A city with very little previous experience in climate change planning is advised to follow this 
sequence.  However, other cities that have already completed some studies or analysis may wish 
to select only parts of the process. The process is also designed to be a continuous cycle of review 
and refinement, rather than a closed cycle as shown in the figure below.

BENEFITS TO CITIES 

Strengthened awareness and 
knowledge about potential risks 
at local level with engagement of 
stakeholders. 

Better understanding of the city’s 
vulnerabilities to climate change 
impacts and therefore better 
management of climate change 
impacts.

Development of a Climate 
Resilience Strategy for improved 
local economic, social and 
environmental resilience of the city.

Integration of the resilience 
strategy into urban planning 
and implementation processes 
and guidance for financing and 
implementation of interventions.

 

 
 

 

 
 

 

- Commitment
- Institutional setup
- Situation analysis
- Communication

- Climate analysis
- Urban analysis
- Climate risk 
assessment
- Risk 
prioritisation

- Vulnerable areas
- Vulnerable social groups
- Adaptive capacities analysis: 
actors and urban systems

- Resilience 
interventions
- Feasibility 
analysis
- Integration
- City Resilience 
Strategy

- Identifying funding options
- Feasibility and project planning
- Governance and monitoring framework
- Project implementation

- Establishment of performance 
indicators and reporting system
- Monitoring and reporting
- Initiation of review phase
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Figure:
The ICLEI ACCCRN Process
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AN INTRODUCTION
ICLEI ACCCRN Process

This version of the toolkit focuses on the first four phases of the ICLEI ACCCRN Process that enable 
cities to prepare of climate resilience strategies; these four phases are briefly described below. 
Phases 5 and 6 that guide cities in the implementation and monitoring phases will be included in 
the following edition of the IAP toolkit.

1. ENGAGEMENT 

Phase 1 of the process will provide all the tools and activities needed to start work with the city. The 
tools help local governments gain the necessary political and administrative support, establish a 
climate core team, involve local stakeholders, appropriately share relevant information through 
a tailored communications plan, and conduct an initial assessment of the city’s progress towards 
dealing with climate change.

2. CLIMATE RESEARCH AND IMPACTS ASSESSMENT

In Phase 2 the main impacts of climate change faced by the city are identified through shared 
learning dialogues and interactions with the climate core team. The fragile urban systems facing 
climate threats are also identified and prioritised according to their risk status.

3. VULNERABILITIES ASSESSMENT

Phase 3 will assist the city government in producing climate vulnerability hotspot maps, in 
identifying the vulnerable social groups, and in analysing their adaptive capacities as well as those 
of the impacted urban systems.

4. CITY RESILIENCE STRATEGY

In Phase 4, city governments will use the information and analysis from the previous Phases to 
develop a list of potential resilience building interventions.  The tools in this phase help screen and 
prioritise these interventions, link them to existing city plans, and compile all the information into 
a City Resilience Strategy.

ACCCRN represents a unique initiative to develop, test and demonstrate practical 
strategies for responding to the impacts of climate change on urban areas. While the 
work of ACCCRN partners focuses on building resilience at the city level, the Network 
is also regional and global in its outlook and outreach. One of the key objectives of 
ACCCRN is to share success stories and encourage cities around the world to replicate 
effective strategies and activities. The Network aims to expand and deepen the base 
of urban climate change resilience work to achieve greater scale beyond the existing 
cities. 
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PHASE 1
ICLEI ACCCRN Process
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ENGAGEMENT
Overview of Phase 1

ICLEI ACCCRN Process

This first phase provides all the tools and activities needed to start working with the city. You will 
identify key stakeholders, both inside the city administration and outside, set up coordination and 
reporting structures, and conduct an initial assessment of the city’s progress towards dealing with 
climate change.

The tools included in Phase 1 and their corresponding objectives are:

Tool 1.1 : Forming a Climate Core Team - to develop a responsible body for driving the ICLEI 
ACCCRN Process in the city, representing the interests of a wide spectrum of the city government’s 
operations.

Tool 1.2 : Forming a Stakeholder Group – to identify the key stakeholders that need to be involved 
in the process and the most appropriate ways of engaging them. 

Tool 1.3 : City Baseline Questionnaire: Impacts & Responses to Climate Change – to document 
the impacts of past climate events in the city and the local government’s responses, and assess 
data availability for a situation analysis.

Tool 1.4 : Climate Ready Review – to assess the local government’s capacity and readiness to 
tackle climate change based on strategies, policies, plans, programmes and procedures.

Tool 1.5 : Communication Plan - to develop a plan for communicating key messages emerging 
from the city’s engagement in the IAP to specific target groups.

Tool 1.6 : Relevant International Initiatives – an optional tool that gives cities the opportunity to 
sign up for related international initiatives that will provide access to international platforms.

TOOL 1.0

An introductory PowerPoint 
presentation on the ICLEI 

ACCCRN Process is provided at 
Reference Tool 1. 

In the later phases of the toolkit you will find some checklists (called ‘Engagement check-
lists’): use them to ensure that the structures established in Phase 1 are still suitable or, if 
needed, to appropriately revise them.
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FORMING 
A CLIMATE 
CORE TEAM

ICLEI ACCCRN Process

The purpose of this tool is to help cities form a Climate Core 
Team (otherwise referred to as Core Team) responsible for 
coordinating the implementation of the ICLEI ACCCRN Process. 
The tool will provide support in identifying core team members, 
establishing terms of reference, and listing the team’s activities 
and responsibilities.

A good Core Team represents the interests of a wide spectrum of 
your city government’s operations.  As such, it can be a valuable 
tool for communicating the goals that the city is aiming to achieve 
through the ICLEI ACCCRN Process and for ensuring that the 
direction your city takes provides the opportunityto address climate 
change considerations across all areas of the city government’s 
activities.

TOOL 1.1
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FORMING A CLIMATE CORE TEAM
Tool 1.1

MEMBERSHIP
Climate change adaptation and resilience building is not just linked to the environment, so 
an effective Core Team will draw on staff from a range of departments. Engaging in the ICLEI 
ACCCRN Process staff from different areas of city operations, with different points of view and 
areas of expertise, is an important early step. 

For example, you may invite participants from the industrial, social, environment, finance and 
planning areas of your city government. The Core Team may consist of representatives from 
city departments who have responsibilities for, or an impact on, development planning, energy 
use, pollution, waste, food security, water security, public health, local economic development, 
infrastructure, and transportation. It is important to identify a Project Nodal Officer for the core 
team who can be the focal point for the process in the city.

In case a similar committee/working group already exists within the city, you could choose to 
consider this body as the ‘Climate Core Team’ as long as it adopts the IAP Terms of Reference 
(mentioned in Exercise 1 below).

SENIOR MANAGEMENT SUPPORT 
It is also important to provide for Senior Management support to the Core Team, to ensure that 
staff members working on the ICLEI ACCCRN Process are directly supported in their day-to-day 
work by management.

EXERCISE 1 – CORE TEAM, ROLES AND RESPONSIBILITIES
The identification of the Core Team members is a very crucial process as the Core Team will 
be responsible for driving the process in your city.  However, it should be noted that the Core 
Team is not a fixed body and new members can be added as and when required. Given below are a 
set of suggested responsibilities that the Core Team should commit to:

• Serve as representatives for their city government’s divisions or sectors
• Attend and participate in the ICLEI ACCCRN workshops to guide the climate resilience programme  
   and expected outputs (tools, materials, reports)
• Lead the city government’s efforts to participate in the programme
• Ensure the ICLEI ACCCRN Process is followed in its entirety
• Make sure that  deadlines for each Phase are met
• Secure the participation of multiple contacts across the city government in the programme
• Organise and deliver workshops and stakeholder consultations with the stakeholder group (see 
    tool 1.2) at different stages of the project, to gather relevant information from them and 
    incorporate their suggestions and inputs as appropriate  
• Coordinate the necessary communication and collaboration with all relevant departments of the 
   city and other stakeholders
• Support internal institutional capacity building to effectively fulfil the long-term climate resilience 
   plan requirements
• Prepare a City Resilience Strategy and facilitate effective integration of planned initiatives into 
    the city’s developmental plans

Who should be part of the 
Climate Core Team?

Senior Management should 
support the Climate Core Team
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In Table 1 below please list the members of the Climate Core Team, their position, and 
proposed responsibilities .

EXERCISE 2 – TERMS OF REFERENCE
Once you have identified your Climate Core Team members, you will need to consider and decide 
an organisational framework for your Core Team. Suggested below are some key elements that 
you should consider:

Step 1: Vision
The Core Team should develop a vision and timeframe, which states how it would like its city to be 
in the future (e.g. in 5 – 10 or 20 years).This vision could be guided by an existing vision statement 
of the city; the team would then need to identify and elaborate further on its climate change related 
elements that can be noted in the table below.

First, note the various elements of the desired vision in the table below. Examples of potential 
elements of the vision are also provided. Please note: keep the focus on the desired outcomes.

Who are your Climate Core 
Team members and what 
should they do?

Name

E.g. Ms. Jane Dev 
Khan 

E.g. Mr. Ibrahim 

E.g. Ms. Gayatri Devi

Chairperson

Project Nodal Officer

Member

Position

Supervising the work of the Core Team 
and providing management support

Coordinating all the activities of the 
Core Team and ensuring its smooth 
functioning

Coordinating activities with the Water 
Resources department

Responsibility

FORMING A CLIMATE CORE TEAM
Tool 1.1

A Project Nodal Officer for the Core Team also needs to be identified who can act as the focal point 
for the process in your city. The main responsibilities of the Project Nodal Officer would be the 
coordination and smooth implementation of the tasks of the Core Team in implementing the 
ICLEI ACCCRN Process. Responsibilities may include:

• Organise meetings of the Core Team as per the agreed schedule
• Facilitate communication and consultation with the stakeholder group 
• Track the city’s progress through the ICLEI ACCCRN Process and inform the Core Team 
   regarding completed and upcoming tasks as laid out in the toolkit
• Facilitate data collection from various departments and other sources



Table 2: Elements of the City Vision - Example

Step 2– Vision Statement 
Now, considering the various elements listed in Table 2, discuss and formulate the Vision 
Statement for your city. For example:

“By 2030 the City of …….. would have climate resilient infrastructure and systems that ensure the 
equitable provision of basic service to all citizens……..”

Step 3 – Monitoring and Reporting 
It is important that the Core Team decides on the monitoring and reporting process for the 
execution of the activities. The Project Nodal Officer can be in-charge for ensuring the reporting 
and thereby monitoring the project.

Step 4 – Terms of office for members
The term of office for the Core Team members needs to be discussed. In case any official is 
completing his/her official term before the conclusion of the process, then the Core Team needs 
to be informed and a substitute official needs to be appointed at the end of the term.

Step 5 – Frequency of meetings
Frequency of meetings should be based on the process guide or adopted project plan.  If possible, 
determine beforehand the schedule for the meetings, time of day, location and maximum length 
of meetings.

Step 6 – Decision making process
It will be helpful to decide the decision making process for the Core Team in advance. This will 
ensure clarity and avoid last minute confusions. 

1

2

3

4

e.g. The city government routinely considers climate impacts in project planning

e.g. Basic services of water, sanitation, energy supply are provided equally to all 
citizens

Elements of the Vision Statement

FORMING A CLIMATE CORE TEAM
Tool 1.1

How would you like your city to 
be in the future?

Set up a structured 
system and process

Have you:

Set up a Climate Core Team and identified a Project Nodal Officer?

Formulated a long-term vision for your city?

Decided on a monitoring and reporting process for the Core Team’s work?

Discussed and agreed upon the terms of office for the Core Team members?

Fixed the regularity and modality of meetings?

Clarified the decision-making process?

ICLEI ACCCRN PROCESS 13



FORMING A 
STAKEHOLDER 
GROUP

ICLEI ACCCRN Process

A stakeholder is “one who is involved in or affected by a course 
of action”. ~ Webster Dictionary 

The ICLEI ACCCRN Process should be supported by consultations 
with other groups in the city such as government agencies, local 
NGOs, community leaders, university partners and private sector 
organisations, to appropriately share responsibilities and ensure 
ownership.  Consultation should be a multi-way process of 
dialogue and deliberation within the Climate Core Team and with 
other stakeholders, as well as amongst stakeholders themselves. 
It is also critical to engage people who are active on issues 
pertaining to poor and marginalized groups, or those most 
likely to be directly affected by the changing climate (this 
may be urban poor groups/ residents themselves or civil 
society groups that have a core focus on the interests of these 
populations).  

You will need to determine what form(s) of stakeholder consultations 
you will conduct; most likely there is already a format being used. 
There may even be existing stakeholders meetings and structures 
that the city has already institutionalised and that can be applied 
to the ICLEI ACCCRN Process.  If this is the case, it is important to 
ensure that such structure has been renewed to have a particular 
focus on Urban Climate Change Resilience. 

TOOL 1.2

ICLEI ACCCRN PROCESS14
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Have the ability to develop 
Resilience Actions at the 
community level

Have the ability to develop 
Resilience Actions at the 
community level

Whose support will be essential 
to implement Resilience 
Actions at different levels (e.g. 
community, city level)

Those most affected by 
Resilience Actions developed 

Characteristics of
Stakeholders

Government 
(local, city, 
national)

Local NGOs / 
CBOs

Academia Community 
Representatives

Private Sectors

FORMING A STAKEHOLDER GROUP
Tool 1.2

The ten core ACCCRN cities have used a particular stakeholder consultation methodology called 
‘Shared Learning Dialogues’ (SLDs). In brief, SLDs allow for multi-dimensional information 
sharing in which everyone contributes information and experience and everyone learns from 
the exchanges.  The SLD process is iterative, with several opportunities for members to meet and 
take their thinking to the next level: this is an approach that the city can consider using.

EXERCISE 1 – FORMING A STAKEHOLDER GROUP
Based on your understanding of the city’s climate risks, current and projected, identify the 
individuals and groups who may:
• be able to develop climate resilience1  actions at the community level 
• be able to develop climate resilience actions at city and/or policy level 
• be able to support climate resilience actions at different levels (community, city)
• be most affected by climate resilience actions developed or supported by other groups 
You can use table 1 to generate a list of stakeholders

Table 1:  Potential stakeholders - Exercise

Please refer to reference tool 2 for 
background information on SLD’s

The following exercise should be undertaken by the Climate Core Team. The Core Team may choose 
to involve other key individuals (from within or outside the City Government) as it may consider 
necessary. The exercise should then be validated by Senior Management.

Please note: this is not a one-
time exercise: the final listing of 
stakeholders can and should be 
revised as and when necessary.   

1 Climate change resilience is the capacity of an individual, community, or institution to dynamically and effectively 
respond to shifting climate impact circumstances while continuing to function at an acceptable level. Simply put, it 
is the ability to survive and recover from the effects of climate change. It includes the ability to understand potential 
impacts and to take appropriate action before, during, and after a particular consequence to minimize negative 
effects and maintain the ability to respond to changing conditions. (Rockefeller Foundation White Paper)

Have you:

Formed a stakeholder group? 

Ensured that it appropriately represent relevant groups in your city? 

Checked that it includes both groups who can support and develop resilience actions as 
well as those mostly affected by them? 
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CITY BASELINE
QUESTIONNAIRE:

ICLEI ACCCRN Process

The purpose of this tool is to identify whether the impacts of climate 
change have been recognised in your city, how those impacts (if 
any) influence activities in development sectors, and what kind of 
support the city government needs to respond effectively. 

The questionnaire below is designed around four primary impacts 
of climate change:

• temperature change, 
• precipitation change, 
• sea level rise, and 
• extreme weather events. 

Once filled out, this questionnaire will provide data and information 
to be used at various points in the following phases of the toolkit.   

TOOL 1.3

IMPACTS & RESPONSES TO CLIMATE CHANGE



CITY BASELINE QUESTIONNAIRE
Tool 1.3

EXERCISE 1 – OVERVIEW OF SECTORAL IMPACTS OF CLIMATE CHANGE
The purpose of this table is to help provide an overview of the perceived climate threats, which main sectors are 
currently impacted and whether there are any ongoing plans or programmes to address these impacts.

Table 1 – Example and exercise

a. Temperature change 

b. Precipitation change

 
c. Sea level rise 

d. Extreme weather events

a. Industry (SME, tourism etc)

b. Food supply (supply and demand, availability)

c. Water supply services

d. Waste water management

e. Solid waste management

f. Transportation (e.g. public transport, number of 
private vehicles etc) 

g. Health (public health and health services)

h. Energy (electricity, fossil fuels, cooking fuels etc)

i. Building (design, energy use)

j. Education (schooling days)

k. Development funds (public and private funds 
available for developmental activities)

1. Compared to a decade ago, have these conditions occurred in your city?

2. Are each of the sectors below being affected by these changes and events?  If so, what plans or actions are already  
     in place to respond?

Yes

Not Known

Yes

Yes

Yes

For example, “there has been a 
perceived increase in temperature 
over the last 20-25 years”

E.g. food supply from surrounding 
areas decreased due to poor rainfall 
and therefore agricultural productivity

E.g. water stress situations durig 
summer months

E.g. “there has been a perceived 
decrease in rainfall over the last” 

QUESTIONS STATUS

Yes No Unknown

INSTANCES/RESPONSES
ACTIONS/PLANS/STRATEGIES
(If marked  ‘yes’ – please elaborate)

ICLEI ACCCRN PROCESS 17



2(a). Please indicate the total area considered to be affected by the above “Yes” changes 
or events

2(b). Please indicate the proportion of the population considered to be affected by the 
above “Yes” changes or events

QUESTIONS STATUS

Yes No Unknown

INSTANCES/RESPONSES
ACTIONS/PLANS/STRATEGIES
(If marked  ‘yes’ – please elaborate)

CITY BASELINE QUESTIONNAIRE
Tool 1.3

a Industry (SME, tourism etc)

b. Food supply (supply and demand, 
availability)

c. Water supply services

d. Waste water management

e. Solid waste management
f. Transportation (e.g. public transport, 
number of private vehicles etc) 

g. Health (public health and health 
services)

h. Energy (electricity, fossil fuels, 
cooking fuels etc)

i. Building (design, energy use)

j. Education (schooling days)

k. Development funds (public 
and private funds allocated for 
developmental activities)

3. For each of the sectors where you have provided a ‘Yes’ response in Question 2, are 
there plans or strategies to deal with extreme events, or to plan for the future more 
generally?  

No

Yes E.g. City Development Plan includes 
measures for rainwater harvesting

Name of the plan

ICLEI ACCCRN PROCESS18



4. Do you believe these climate changes will increase in the future for your city?

5. What does your city need to do to improve resilience to climate change?

QUESTIONS STATUS

Yes No Unknown

INSTANCES/RESPONSES
ACTIONS/PLANS/STRATEGIES
(If marked  ‘yes’ – please elaborate)

CITY BASELINE QUESTIONNAIRE
Tool 1.3

a. Temperature change

b. Precipitation change

c. Sea level rise 

d. Extreme events

a. Capacity development

b. Technical assistance 

c. Funding/Finances

Not Known

Yes E.g. Observations of the past trends 
seem to indicate that temperature will 
increase

Please elaborate

Please elaborate

Please elaborate

ICLEI ACCCRN PROCESS 19
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CITY BASELINE QUESTIONNAIRE

EXERCISE 2 – OVERVIEW OF CITY RESPONSES TO CLIMATE CHANGE
Weather anomalies and extreme weather events (flooding, heat waves, cyclones, and 
tidal surges), strain private (homes), commercial (businesses and enterprises) and public 
infrastructure (buildings, roads and bridges), place stress on society and can temporarily shut 
down parts of the local economy (transport of goods and service provision).  

The ability of city governments to anticipate and be prepared for weather anomalies 
and extreme weather events will help to mitigate the potential social and economic 
consequences associated with extreme weather events and anomalies in the future.  

What three weather anomalies or extreme weather events has your city responded to in the 
past (last 30 years)?  

For one of the events listed above (e.g. the most severe one), describe the event in detail. 
In describing the event, consider the following:  

Event 1

What was the event?

What was the duration of 
the event/how many days/
months did it persist?

When did it happen?

Who was impacted and how?

Has this event occurred 
before? 

Any other information?

If so, was the earlier 
event more or less severe 
than the last event?

What geographical area 
was affected?

Event 2

Event 3

Tool 1.3

Consider weather anomalies or 
extreme weather events such 
as flooding, heat waves, drought 
(water stress), cyclones, storms, 
tidal surges.
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What were the social, economic and environmental impacts of this event? 

Urban systems 
impacted

Social 
impacts

Economic 
impacts

Environmental 
impacts

Consider the urban systems that were impacted by this event, e.g. water 
supply, drainage, health

Consider the social impacts of this event, e.g. people’s homes were flooded, 
people were displaced, there was an increase in water-borne diseases, 
water and food supply was disrupted.

Consider the economic impacts, e.g. shops were closed, transportation links 
were disrupted, production was stopped. 

Consider the environmental impacts, e.g. land quality was affected by flood-
ing, saltwater intruded into ground and surface waters, trees were blown 
down, animals died. 

Tool 1.3
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How did the city government respond to this event?
List the different responses below

1.

2.

3.

4.

5.

6.

Which city departments were involved in these responses?

1.

2.

3.

4.

5.

6.

Which stakeholders (beyond the local government) were involved in these responses?  
Indicate what type of relationship, if any, each stakeholder has with the city (e.g. partner, collaborator, 
adviser…).

1.

2.

3.

4.

5.

6.

CITY BASELINE QUESTIONNAIRE
Tool 1.3
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Did the city government have a policy and response plan in place that anticipated the event?  
Had the city government already incorporated weather anomalies into its planning and decision-making? 
If so, please list the various policy and response plans.

1.

2.

3.

4.

5.

6.

Based on the experience developed so far, what can your city government do to anticipate, 
prepare and respond to weather anomalies and extreme weather events in the future? 
Please list

1.

2.

3.

4.

5.

6.

CITY BASELINE QUESTIONNAIRE
Tool 1.3



EXERCISE 3 – EXISTING WEATHER DATA
This section aims to help gather and analyse some basic information regarding past weather 
data for the city. This will help understand some trends and patterns in temperature and 
precipitation. This analysis can be substantiated with inputs from an expert, but even the 
preliminary results will help provide a broad understanding on whether there have been any 
significant changes in weather patterns. Please record the data for the longest period for which it 
is available (minimum of past 30 years is recommended).  

Table 3:  Precipitation Data - Exercise

Table 2:  Temperature Data - Exercise

Record the data for the longest 
available period – 30 years 
minimum

Years

Years

Annual Maximum
Temperature

Seasons (please define the seasons for your region/country)

Annual Minimum
Temperature

Average Annual Rainfall 
(mm)

Annual Average
Temperature

Source: Please insert the source of the information

Source: Please insert the source of the information

     eg. Jan-Mar	          Apr-Jun	          Jul-Sep                  Oct-Nov
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The temperature and precipitation data can be plotted on a graph using for example MS Excel 
or similar softwares; a trendline for each of the various parameters (i.e. annual minimum 
temperature; annual maximum temperature; average annual rainfall etc.) can also be assessed. 
These trendlines will provide an indication of the change in these parameters over time.

EXERCISE 4: MAPPING OF DATA
It is recommended that you start producing maps of key data as early as possible in the ICLEI 
ACCCRN Process. In Phase 3 of the toolkit it will be necessary to map vulnerability data and any 
earlier maps can be used as input for this step.  

Whenever possible, use digital mapping tools possible to help capture, analyse and present 
data. Several cities already have, or are developing, Geographic Information Systems (GIS) based 
maps. In case GIS maps for the city are not available, there exist several software products that 
can be found freely online and can be used to produce base maps for the city, on which layers of 
data for different geographical locations can be added. If this capacity does not exist within the 
city government, it is recommended to hire the services of a skilled IT person to facilitate this.

In case of limited access to the internet, hard copies of maps can also be used for participatory 
mapping exercises. These maps can then be scanned. 

If possible, use the data collected in Exercises 1 to 3 to develop some baseline maps for your 
city showing the distribution of climate events and impacts . These can be refined progressively 
throughout the process.

Start producing maps of key 
data as early as possible

Use the data collected in 
Exercises 1 to 3 to develop 

some baseline maps

Reference Tool 3 contains detailed 
methods for mapping areas within a 

city or any study region using open 
source software. 

CITY BASELINE QUESTIONNAIRE
Tool 1.3



EXERCISE 5 – AVAILABILITY OF DATA
The purpose of this exercise is to identify what data is already available to assist the ICLEI ACCCRN analysis.  You are not asked to 
provide the actual data at this stage, but rather to indicate its availability; you might need the data in later tools.  

Table 4 - Exercise

Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Geographic area of the city 
considered most vulnerable to 
climate change

Area under green cover

Total area of agricultural land
Regional crop seasons
Primary crop
Secondary crop
Contribution to local economy

Contribution to local food 
requirement

Number of water bodies
Classification of water bodies
Depth of ground water table
Water quality

Area of city regularly subject to 
flooding

Types of ecosystems available 
(wetlands, riverine, forest etc)

Proportion of population vulnerable 
to climate change, disaggregated by 
gender & poverty

Mapping and 
area

Sq Km

Sq km
Months
Names
Names
Percentage of 
total GDP

Percentage  

Number, sq km
Number, sq km, type
Metres

As per pollution 
control board 
categories

Sq km

Number / area

Percentage, 
gender, poverty

Vulnerability and Poverty (High Level Indicators)

Ecosystems/ Biodiversity

Agricultural Resources

Water Resources
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Table 4 - Exercise (contd.)

Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Total population 

Population break up: gender: no of 
females/ 1000 males

Population break up: age

Population density: average

Population distribution: ward/zone/
area wise

No of households

Average size of household

Floating/itinerant population1 

Rate of annual inward migration

Rate of annual outbound migration 

Employment rates (%)

Employment distribution (M/F)

Nature of occupation

Primary occupation

Secondary occupation

Occupation distribution (M/F)

Occupation distribution (economic)

Informal sector2: numbers, categories

Number

Number

Number (in categories)

Number/ Sq km

Number/ Sq km

Number

Number

Number

Persons/ year

Persons/ year

Percentage

Percentage

List

Percentage from list

Percentage from list

Percentage within list

Percentage within list

Demographics 

Population

Employment  

1A group of people who reside in a given population for a certain amount of time and for various reasons, but are not generally considered part of the official 
census count
2The informal sector or informal economy is that part of an economy that is not taxed, monitored by any form of government or included in any gross national 
product (GNP), unlike the formal economy
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Average literacy rate 

Literacy distribution (M/F)

Infant mortality rate

Maternal mortality rate

Total number of deaths per year 
from communicable diseases 
(number/year)

Disease deaths distribution (M/F)

Total number of deaths from 
calamities/ extreme climate events/ 
disasters (number/year)

Number of infant vaccinations 
administered per year

Prominent diseases list

Seasonality of diseases

Main economic activities 

Population living in slums

Population of minority groups

Population considered vulnerable 
to climate change (temperature, 
precipitation, sea level rise, extreme 
weather)

Percentage

Percentage

Number/ year

Number/ year

Number/ year

Number/ year

Number/year

Number/ year

List

Months

List most important to 
less important

Number

Number

Number, gender

Demographics 

Health

Economy

Literacy

Morbidity

Disease

Vulnerable Groups
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Total city area

Zoning/ land use

Informal or unauthorised 
settlements

Slum areas (for both ‘officially 
recognized / classified’ & ‘not 
officially recognized / classified)

Topography

Apartments

Single-family dwelling3

Huts, temporary houses and slums

Housing units considered at risk of 
flood or storm damage

Sq km

Area of different land 
uses, with map

Number and area

Number and area

Topographic map with 
ward/zone/area

Number of properties, 
ward/zone/area wise 
distribution

Number of properties, 
ward/zone/area wise 
distribution

Number of properties, 
ward/zone/area wise 
distribution

Number of. properties, 
locations

Land

Housing

3 The building is usually  occupied by just one household or family and consists of just one dwelling unit or suite
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Water supply distribution network

Number of authorised residential 
connections

Number of authorised commercial 
connections

Households with piped water supply

Households having water meters

Taps, hand pumps, tube wells, 
tankers

Total amount of water supply 

Total amount of water demand 

Total non-revenue water (NRW) / 
unaccounted for water (UFW) 

Sources of fresh water in the city

Water treatment plant

Maps to scale, with 
ward/zone/area wise 
breakup; % coverage of 
network

Number of ward/zone/
area wise distribution

Number of ward/zone/
area wise distribution

Number, percent

Number, percent

Number

MLD

MLD

MLD

Names and capacity 
in ML

Number, capacity, 
location, ward/zone/
area covered

Infrastructure

Water supply
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Sewage distribution network

Total length of sewage network 
pipes

Total length of underground sewage 
pipes

Average age of network pipes

Volume of waste water generated 
per day

Volume of waste water collected

Volume of waste water treated

Volume of treated water reused

Sewage treatment plant

Households connected to sewage

Solid waste generated per day

Amount of waste collected

Amount of waste treated

Categorisation of solid waste

Solid waste treatment facility

Scientific landfills

Open dump sites

Map and % coverage

Ward/zone/area wise 
distribution

Kms

Years

MLD

MLD

MLD

MLD

Number, capacity, 
location, ward/zone/
area covered

Number, percent

TPD

TPD

TPD

Percentage of total 
solid waste generated

Number, capacity, 
location, ward/zone/
area covered

Number, capacity, 
location, ward/zone/
area covered

Number, capacity, 
location, ward/zone/
area covered

Infrastructure

Sewage

Sewage
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Total length of road network

Total length of concrete/sealed/
made roads

Main types of industry

Total number of work force 
employed

Percentage contribution to total 
economy

Polluting industries

Type of public transport systems 
available

Low Emissions public transport 
systems

Drainage distribution network

Total length of covered network

Total length of uncovered network

Average diameter of pipes

Kms

Kms

List

Number/ Percentage of 
total workforce

Percentage

Number, location and 
list

List

Map with ward/zone/
area

Kms

Kms

Use appropriate unit

Infrastructure

Economy

Roads

Industry

Transportation network

Storm water drainage
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Main types of services

Total number of work force 
employed

Percentage contribution to total 
economy

Total annual supply

Main source of supply

Total annual energy demand

Sector wise energy usage 
(residential / commercial / 
industrial)

Average number of hours of 
electricity supply

Total annual supply

Total annual demand

Sector wise petrol usage

Port/Harbour, etc

Airport

Road network

Rail

Number, location and 
list

Number/ Percentage of 
total workforce

Percentage

MU

Percentage share, 
types

MU

Percentage share, 
types

Hours/ day in Winter / 
Summer / Monsoon

KL

KL

Percentage share, 
types

Yes / No

Yes / No

Yes / No

Yes / No

Infrastructure

Energy

Commerce

Electricity

Petrol

Access to the City
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Total annual supply

Total annual demand

Sector wise diesel usage

Total annual supply

Total annual demand

Sector wise Kerosene usage

Total annual supply

Total annual demand

Sector wise Fuel wood usage

Total annual supply

Total annual demand

Sector wise FLPG usage

Total annual supply

Total annual demand

Sector wise CNG usage

KL

KL

Percentage share, 
types

KL

KL

Percentage share, 
types

KL

KL

Percentage share, 
types

KL

KL

Percentage share, 
types

KL

KL

Percentage share, 
types

Energy

Diesel

Kerosene

Fuel wood

LPG  

CNG
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Category Unit Is Data Available?
Yes/No

Source of Data? Time period for 
which data
available

Number of Solar Water Heating 
systems

Number of solar cookers

Number of wind energy systems

Biogas plants

Rooftop SPVs

Number and 
cumulative capacity

Number and 
cumulative capacity

Number and 
cumulative capacity

Number and 
cumulative capacity

Number and 
cumulative capacity

Energy

RE share

Have you:

Prepared the overview of the sectoral impacts of climate change in your city?

Listed past and possible responses to weather anomalies and extreme weather events?

Collected and analysed past weather data?

Developed a map of key data?

Assessed the availability of data, that you might later need in the process?

ICLEI ACCCRN PROCESS 35

CITY BASELINE QUESTIONNAIRE
Tool 1.3

Table 4 - Exercise (contd.)



ICLEI ACCCRN PROCESS36

CLIMATE READY 
REVIEW

ICLEI ACCCRN Process

The Climate Ready Review is a self-assessment tool that will help 
gauge your city’s capacities and readiness to tackle climate change.  
It is based on six aspects of your organization: 

• Strategies, Policies, Plans and Procedures 
• Information, Data, Tools and Processes 
• Budget Allocation and Financing Processes
• Staff Participation
• Existing Initiatives
• Community Engagement

The Climate Ready Review uses a questionnaire-based approach in 
each of these six areas to highlight a city’s success, identify where 
there is room for improvement and encourage cities to foster a 
cycle of continuous improvement within the city’s culture. 

The questions of the Climate Ready Review are not exhaustive and 
are intended to provide a guide to assist cities to develop an internal 
benchmark by which to measure its functioning and improve upon.  
Further, the questionnaire is not intended as a tool to benchmark 
cities implementing the ICLEI ACCCRN Process – it is only for your 
own internal benefit.  

INSTRUCTIONS 
The Climate Ready Review comprises of a series of questions 
broken up into six key areas. Record your response to each 
question in the appropriate box, including supporting information 
in the Comments box.  This information is important for a full 
understanding and assessment of your city’s current situation. 

How to undertake the Climate Ready Review:
The Climate Core Team should meet to discuss and 
collectively undertake this exercise, ideally in consultations 
with all relevant staff, including senior management and 
external parties where required, to ensure that the Climate 
Ready Review provides a benchmark assessment as accurate 
as possible.

TOOL 1.4



1. STRATEGIES, POLICIES, PLANS, PROCEDURES
This section refers to existing city strategies, policies, plans, and organisational procedures 
currently in place (or any proposed changes). This review enables the city to identify if climate 
considerations are part of the current strategic direction and organisational frameworks. 

Including climate change considerations into the strategic direction of the city government is 
crucial to building internal support and mobilising resources (time, human resources, skills) 
necessary for the city to respond to anticipated climate change impacts in a measured and 
productive manner.

Table 1.1 – Exercise 

CLIMATE READY REVIEW
Tool 1.4

Do your existing strategies, 
policies, plans and procedures 
already include environmental 

considerations?

1.1 Strategies Yes No Comments Hints

What are the medium to long term 
strategic priorities / goals of your city? 

Are climate change issues (current and/
or future) identified in the city’s strategic 
priorities / goals?

Summarise the 
social, economic and 
environmental goals of 
the city. Refer to Plan 
documents

List issues and 
concerns, such as 
conservation of natural 
resources, protecting 
natural environments, 
water conservation, 
extreme weather events 
– flooding, droughts, 
heat waves. 
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CLIMATE READY REVIEW
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Table 1.2 – Exercise 

1.2 Plans and Policies Yes No Comments Hints

Which plans or policies integrate social, 
environment, economic elements?	

Does your city have an environmental 
plan or policy? 	

Does your city have a disaster 
management plan or policy? 	

Does your city have a climate change 
policy or plan? 	

Does your city have any policies, plans, 
guiding statements or other city directives 
that are used to direct actions to reduce 
energy use and pollution?	

Please detail other ways in which your 
city could integrate climate change 
considerations into existing city policies 
and plans.	

Does your city use environmental and/
or disaster risk reduction criteria in its 
decision-making?

If yes, what types of projects typically 
assess environmental and/or disaster 
risk reduction criteria?
	

Name the policies 

Name the policy. State 
when the policy was 
established.

Name the policy. State 
when the policy was 
established

Name the policy. State 
when the policy was 
established.

Name the policy. State 
when the policy was 
established.

Consider energy use, 
pollution and emerging 
and future climate 
change issues.

List the environmental 
and/or disaster risk 
reduction criteria. Has 
your city developed 
these criteria? For 
example, criteria for 
contracts to industries, 
building work or other 
development activities.
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2.1 Information, data, tools and processes Yes No Comments Hints

Does your city use any information-based 
geographical tools (maps, geographical 
information systems)?

If yes, please mention tools and their use.

Does your city have access to local or 
regional climate projections or climate 
impact scenarios? 

If not, which national or state agencies 
are responsible for holding weather and 
climate-related information?

Please detail other ways in which your 
city may improve access to environment 
and climate information.

Examples of tools are 
institutional maps, 
zoning maps, socio-
economic profile maps, 
hazard maps, future 
growth maps, GIS based 
planning tools 

National agencies are 
using global climate 
change projections to 
inform local climate 
change projections that 
estimate environmental 
changes over the long 
term. 

2. INFORMATION, DATA, TOOLS AND PROCESSES 
Climate and energy-related information and systems that process and manage that 
information are crucial to help city staff make better and more informed decisions about climate 
change issues in their day-to-day work, in implementing the city’s environment and climate-
related policies, and in tracking and reviewing progress of plans and individual actions. 

Table 2 – Exercise

What access does your city have 
to environment and climate 

information?



CLIMATE READY REVIEW
Tool 1.4

3. BUDGET ALLOCATION AND FINANCING PROCESSES
Allocated budget and financial resources are paramount to implementing climate change, 
disaster risk reduction and environmental actions. City governments can, and do, implement 
a suite of innovative climate change projects with very limited financial and human resources, 
e.g. implementing energy saving measures - these actions are commonly referred to as ‘low-
hanging fruit’. However, city governments commonly encounter problems in accessing financial 
resources necessary to move beyond the ‘low-hanging fruit’. City governments are therefore 
encouraged to develop sufficient budgets for climate change projects and to seek external 
funding opportunities to supplement city budgets.

Table 3 – Exercise  

4. STAFF PARTICIPATION, TRAINING AND SUPPORT
Educating and raising the awareness of staff helps to build staff capacity and skills to 
incorporate climate change considerations as part of their decision-making, both in their role 
at the city government and in their role as a citizen. This, in turn, can improve organisational 
performance and can build further internal support for climate change initiatives.

Table 4 – Exercise

3.1 Budget allocation and
financing processes

4.1 Staff Participation,
Training and Support

Yes

Yes

No

No

Comments

Comments

Hints

Hints

Does your city have a specific budget 
allocation for disaster risk reduction, 
environmental or climate change 
projects?

Please detail other ways in which your 
city may access funding for its disaster 
risk reduction, environmental or climate 
change projects.

Does the city offer staff training on 
climate change, disaster risk reduction, 
environmental/energy/climate-related 
initiatives?

Describe the climate 
change, disaster 
risk reduction, or 
environmental projects 
covered by specific 
budgets.

Training could be 
provided as part of 
specific projects, or 
other training events.

What access does your city 
have to appropriate financial 
resources for your climate 
change projects?

What kind of climate related 
training does the city offer to 
staff?
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CLIMATE READY REVIEW
Tool 1.4

5. EXISTING INITIATIVES
This section covers specific climate change related initiatives that the city has implemented. In 
this section, city staff must identify initiatives that have helped the city to manage current 
climate change issues (e.g. such as conserving energy, improving access to clean water) as well 
as to prepare for emerging and future climate change issues (such as extreme weather events, 
higher temperatures, intense storms and rainfall, flooding, and sea level rise). 

   Make sure to include Disaster Risk Reduction (DRR) initiatives too!

Responses to this question will form part of the city’s Climate Resilience Strategy.

Table 5 – Exercise 

5.1 Ongoing Projects

Sector Project

Benefits Costs

Project Duration of the project Achievements

What past or existing initiatives 
are already helping manage 

climate change issues?

Water supply

Is your city a member 
of UNISDR’s “Making 
My City Disaster Resil-
ient” Campaign?

Any DRR initiatives?

Description of intended/
unintended action. 

Project 
benefits (cost 
savings, re-
duced energy 
use)

Project 
costs 
(higher 
capital 
costs)

Start and end dates
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6. STAKEHOLDER ENGAGEMENT
City government facilitated programmes are crucial to educating and raising the awareness 
on environmental issues in the community. In this section , the city must identify programmes 
and initiatives that demonstrate the city is engaging the community on climate change, disaster 
risk reduction, and environmental matters, such as disaster preparedness, energy and water 
conservation, and pollution. 

Table 6 – Exercise 

6.1 Community Yes No Comments Hints

Does your city work with the community 
in any way to facilitate disaster risk 
reduction, environmental or climate 
initiatives?

If so, which sectors of the community? 
And which projects?

Please detail other ways in which your city 
could engage the community on climate 
change issues.

Describe initiatives and 
sectors involved.

Consider current, 
emerging and future 
climate change issues.

Which on-going programmes 
already engage the community 
on climate change and 
environmental issues?
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NEXT STEPS
Following the completion of the Climate Ready Review, your city should write a summary report 
that:

• Identifies where the city is performing well
• Identifies where there is room for improvement
• Identifies actions to improve performance
• Commits the city to a cycle of continuous improvement within the city’s culture
• Commits to completing the Climate Ready Review at Phase 2 of the ICLEI ACCCRN Process

Reference Tool 4: Local 
Government Self Assessment 
Tool for Disaster and Climate 

Preparedness

Given how closely climate change 
adaptation (CCA) and disaster risk 

reduction (DRR) are connected, the 
ICLEI ACCCRN Process provides 

a link to the Local Government 
Self Assessment Tool (LGSAT) 

developed by the United Nations 
Office for Disaster Risk Reduction 

(UNISDR).

Have you:

Listed existing strategies and plans that already include environmental considerations?

Analysed what access your city has to environment and climate information?

Assessed the availability and/or accessibility of financial resources for your climate 
change projects?

Looked into already existing climate related training for the city staff?

Identified past and current initiatives that are already helping manage climate change 
issues

Listed existing community engagement programmes, related to climate change and the 
environment?
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DEVELOPING A 
COMMUNICATION 
PLAN

ICLEI ACCCRN Process

Climate change may be a new topic for some people, it may raise 
anxiety levels or even negative reactions among stakeholders unless 
the rationale is carefully explained. Developing a Communication 
Plan at the start of the process will help you avoid these risks 
and gain the engagement of the relevant stakeholders you 
need to carry out your city’s resilience process.  

Start by developing some clear messages about why the City is 
undertaking this work and what it hopes to achieve. Throughout the 
process there will also be other moments when clear messaging 
will be important, e.g. after the initial climate risk analysis has been 
undertaken.

How to develop the Communication Plan:
The Climate Core Team should meet to discuss and collectively 
undertake this exercise, following the recommendations 
below.

TOOL 1.5
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EXERCISE 1 – WRITING THE COMMUNICATION PLAN
Use the following headings to develop a Communication Plan for your process:
• Objectives
• Target audience
• Key messages
• Media
• Timing

Step 1 Objectives 
First, write some broad objectives you plan to achieve with your communication activities. Some 
examples:
(i) Build awareness among your community regarding climate threats that the City faces, especially, 
as the case may be, on existing challenges that could be exacerbated due to these threats
(ii) Inform your community about the adaptation strategies that the City proposes to undertake in 
order to deal with these threats and ensure the citizens’ well being
(iii) Encourage  citizens to be involved in the decision making processes by soliciting their ideas 
and inputs
(iv) Suggest how actions taken by individuals and groups can contribute towards the City’s resilience

Care should be taken in the kind of terminology chosen: the use of complicated and technical 
terms should be avoided, and risks and proposed actions that the community can relate to should 
be used (i.e. securing the health and well being in the event of heat stresses). 

Step 2 Target Audience 
Once you have defined your objectives, list the stakeholders that you intend to reach with your 
communication plan.  Begin with the groups listed in Tool 1.2.  

DEVELOPING A COMMUNICATION PLAN
Tool 1.5

What do you aim to achieve with 
your communication activities?

Whom are you talking to?
Target Audience 

Group
Contact
Details

Primary Contact  – Name & 
Telephone number / email
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DEVELOPING A COMMUNICATION PLAN
Tool 1.5

Step 3 Key Messages  
Now decide which key messages you want to communicate to each target audience at the 
beginning of the process - remember that new messages will be needed as you learn more about 
how climate change will impact your city and how to respond to it. 

Example (adapted from The Climate Impacts Group, King County & ICLEI’s Preparing 
for Climate Change Guidebook)

Developing Key Messages

Describe changes that have already been observed. There are many indications that the 
Earth’s climate and various physical and ecological systems are changing. Some of these 
may be changes that local residents have observed first-hand. Including this information can 
underscore that climate change is occurring and, in many respects, having a measurable 
impact on Earth’s systems. Be careful not to attribute observed changes to human-caused 
climate change entirely, unless there is scientific evidence to back up the claim.

Describe changes that are expected. Using the information you collected in your Scoping 
Exercise and any additional information collected later, provide information on how 
temperature, precipitation, snowpack, and other aspects of climate and the environment 
are expected to change in your region as a result of climate change.

Describe how climate change may impact the community. Using the information you collected 
in your Scoping Exercise, explain the potential regional and local consequences of climate 
change. Impacts may include sea level rise, changes in water supply, and increased risk of 
drought, forest fires, extreme events, flooding, and/or disease. Be careful not to overstate 
what you know about impacts to your region or you risk losing credibility with key audiences.

Identify other communities similar to yours that are planning for climate change. It may 
be helpful for people to see that other communities similar to yours are taking steps to 
address climate change impacts. The 10 pilot cities under ACCCRN and the other 2 cities 
that are implementing the ICLEI ACCCRN project, as well as others, are good resources 
for identifying other communities working on climate change activities. With time, it will 
be possible to focus on those strategies that have worked for other City Governments like 
yours. Identifying your peers and exchanging experiences can be empowering and helpful.

What messages are you trying 
to convey?

Target Audience 
Groups

Key Messages

Eg. City departments

Eg. Community group

The City is participating in ACCCRN. Your involvement is 
required

The City is participating in ACCCRN. The City will be holding 
forums to hear from community groups
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DEVELOPING A COMMUNICATION PLAN
Tool 1.5

Step 4 Media
Decide on the most appropriate media and channels you will use to deliver the messages.

Develop a course of action. Outline what you intend to achieve and the steps your City 
intends to take to prepare for the projected changes. Update your message with details 
on your community’s course of action as the planning process progresses and your plan is 
implemented.

Acknowledge that questions remain. Do not be reluctant to admit that questions remain. 
Clearly communicating what you do know – while being honest about what questions 
still need to be answered – will be critical to gaining and maintaining credibility, interest, 
understanding, and support for your preparedness work. Be sure to emphasize, however, 
that enough information is available for (and warrants) moving forward with planning.

Example: Approaches that could be used for engaging citizens
    
• Develop climate vulnerability assessments of the City. A non-technical version of the 
document could be shared with the citizens and their feedback solicited 

• Produce communication products such as pamphlets that identify the climate 
vulnerabilities of the city, proposed adaptation activities and actions, as well as sources of 
more information and how citizens can get involved

• Organise public consultations in which potential climate impacts and corresponding 
adaptation plans are discussed

• Make use of web-based interactions – citizens can be invited to share their points of view 
and ideas on adaptation measures

• Coordinate community meetings in different and diverse parts of the community to solicit 
feedback and ideas – civil society organizations could facilitate such a process

• Share GIS-based climate change vulnerability maps for communicating and reviewing 
local areas most likely to be impacted by climate change

• Make the most of various media (audio, video, print, electronic) to spread climate change 
awareness throughout a larger audiences

How will you get your messages 
through’?
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DEVELOPING A COMMUNICATION PLAN
Tool 1.5

Step 5 Finalise the Communication Plan  
The following table can be used to summarise and track your communication.

Target
Audience

Activity TimingObjective, 
Message

Communication 
Medium

Achieved
yes/no

E.g. City
Departments

E.g. Residents, 
Local Business

E.g. City 
Departments

Inform all city 
departments 
that the city 
government is 
participating in 
ICLEI ACCCRN 
project

Inform citizens 
that the City is 
participating in 
the ICLEI 
ACCCRN project

Recruit staff to 
participate in the 
project, and 
identify Climate 
Core Team 
members

Internal Launch

External 
Launch

Staff 
recruitment

Newsletter, staff 
meetings

Media release

Newsletter

October

October

October

Now finalise your 
communication plan!

Please Note: The communication plan is not a one-time document and should be updated from time 
to time. For example, the key messages emerging from each phase of the process can be used to 
update the plan . 
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DEVELOPING A COMMUNICATION PLAN
Tool 1.5

Have you:

Listed the objectives of your communication activities?

Identified your main target audience?

Developed your key messages?

Decided which channels to use to convey them?

Drafted and finalised your communication plan?



ICLEI ACCCRN PROCESS50

RELEVANT 
INTERNATIONAL 
INITIATIVES 

ICLEI ACCCRN Process

Now  that your city has undertaken the ICLEI ACCCRN Process to assess your climate risks and 
develop resilience strategies, you have an opportunity to sign up for relevant international initiatives 
that will provide you with access to additional resources as well as an international platform to 
showcase achievements and interact with other cities.Below you find some of these initiatives:  

1. MY CITY IS GETTING READY CAMPAIGN
ICLEI works in partnership with the United Nations Office for Disaster Risk Reduction (UNISDR) to 
offer the My city is Getting Ready Campaign.

This campaign was launched in 2010 and there are now more than 1500 cities around the world 
participating. The Campaign provides support for cities to become more disaster ready, including 
a Local Government Self Assessment Tool (LGSAT). This tool can be used as part of the ICLEI 
ACCCRN Process in Phase 1, or as an action in your Resilience Strategy.

2. CARBONN CITIES CLIMATE REGISTRY
The carbonn Cities Climate Registry (cCCR) is a global mechanism that encourages local 
governments to regularly and publicly report on their greenhouse gas reduction commitments, 
GHG emissions inventories and climate mitigation/adaptation actions. The cCCR was developed by 
local governments for local governments and is hosted by ICLEI. 

The cCCR enables cities and local governments to publicly register their greenhouse gas reduction 
commitments, report performance and showcase actions.

TOOL 1.6

For further information on the 
Campaign and the self assessment 
tool, please see Reference Tool 4.
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3. DURBAN ADAPTATION CHARTER
The Durban Adaptation Charter was launched at the United Nations Framework Convention on 
Climate Change (UNFCCC) Conference of the Parties (COP) 17 held in the City of Durban (eThekwini 
Municipality), South Africa, in December 2011, during the ‘Durban Local Government Convention: 
adapting to a changing climate - towards COP17/CMP7 and beyond’. The convention was hosted by 
the South African Government, through the South African Local Government Association (SALGA), 
South African Cities Network (SACN), eThekwini Municipality and the Department of Environmental 
Affairs, and in partnership with ICLEI.

The Charter commits Local Governments to local climate action in their jurisdiction that will assist 
their communities to respond to and cope with climate change risks thereby reducing vulnerability. 
Its initial signing by 114 signatories, representing 950 local governments organisations from 27 
countries, builds on the recognition of local governments as government stakeholders in the 
Cancun Agreement.

By carrying out the ICLEI ACCCRN Process your city government has initiated its action towards 
making your city climate resilient. The signing of the Durban Adaptation Charter will enable your 
city to reach out to a larger audience and showcase its commitment and actions for climate 
resilience on an international platform.

4. 100 RESILIENT CITIES CHALLENGE1

The Rockefeller Foundation launched the 100 Resilient Cities Challenge (100RC) in 2013 to enable 
100 cities to better address the increasing shocks and stresses of the 21st century. It is dedicated 
to helping cities around the world become more resilient to the physical, social and economic 
challenges that are a growing part of the 21st century.   

Cities in the 100RC network are provided with the resources necessary to develop a roadmap to 
resilience along four main pathways:

1. Financial and logistical guidance for establishing an innovative new position in city government, 
a Chief Resilience Officer, who will lead the city’s resilience efforts;

2. Expert support for development of a robust resilience strategy;

3. Access to solutions, service providers, and partners from the private, public and NGO sectors 
who can help them develop and implement their resilience strategies; and

4. Membership of a global network of member cities who can learn from and help each other.

Nearly 400 cities across six continents applied to be among the first cities selected to receive 
technical support and resources to improve their urban resilience over three years. The first group 
of 32 cities was announced on December 3, 2013, selected by judges with unique expertise on tools 
and strategies that make a city better prepared to face natural and manmade disaster. 
Support will be extended to additional cities in ensuing batches. In order to participate in the 
challenge please see: http://www.100resilientcities.org/pages/about-the-challenge

RELEVANT INTERNATIONAL INITIATIVES 
Tool 1.6

For further information please see 
Reference Tool 6 

For further information please see 
Reference Tool 5

1Source: adapted from www.100resilientcities.org
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CLIMATE
RESEARCH 
AND IMPACTS
ASSESSMENT 

Overview of Phase 2

ICLEI ACCCRN Process

In this Phase you will analyse available climate change data and develop a projection of likely 
climate changes for a future year, then use this projection to assess the likely impact on critical 
urban systems and resultant risks.

The tools included in Phase 2 and their corresponding objectives are:

Tool 2.1 : Climate Exposure: Projections & Scenarios - to collate and analyse climate change 
data and generate climate exposure scenarios or projections 

Tool 2.2 : Urban Systems Analysis - to assess the city’s fragile urban systems and services 
already under great stress and the expected impacts of climate change on them 

Tool 2.3 : Risk Assessment - to prioritise the expected climate impacts based on an assessment 
of their risk status 

TOOL 2.0
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CLIMATE EXPOSURE: 
PROJECTIONS
& SCENARIOS

ICLEI ACCCRN Process

Phenomena such as increased precipitation, heat stress, 
floods and other extreme weather events, referred to as 
climate exposures, are increasingly having an impact on people, 
infrastructure and systems within cities. 

This tool aims to help your city to collate and analyse climate 
change data and generate at least one climate exposure scenario, 
or projection. Ideally, the city will be able to use local climate data; 
however, if this is not available, the tool suggests other sources for 
conducting the analysis. 

The tool is divided into two sections. Section A suggests sources 
of climate data and the process of collating and documenting this 
data. Section B gives guidance for a preliminary analysis of the 
data and for writing a Climate Scenario Summary Statement.

TOOL 2.1

How to undertake the Climate Analysis:
It is suggested that the Climate Core Team meet to discuss and 
collectively undertake this exercise.

Consultations with climate experts are highly recommended.  
Such experts can be available locally and be part of the 
Stakeholder Group or their services may have to be hired.
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SECTION A CLIMATE DATA COLLATION 
First, try to find local level climate data and any other data sets or recent studies on climate 
phenomena and projections for your own area .  This material may be available from the city’s own 
records, universities or research institutes, NGOs or other bodies (consultation with members of 
the Stakeholder Group established in Phase 1 could help facilitate this process).  

If there is no local level assessment available, look for a regional assessment. For example, the 
Indian Network for Climate Change Assessment’s (INCCA) Report gives projections for 2030 for 
some regions in India.  Similarly, the Indonesian Government in collaboration with AusAid and 
GIZ has developed climate projections for several regions of Indonesia (KRAPI project). Regional 
data will provide a good base level of data; even if it is generalised to a wider area than your city 
boundaries, it may still be sufficient to initiate discussions on anticipated climate changes at the 
city level. 

You will be using the trends of the higher scale projections (e.g. increase in average annual 
temperatures can be expected by 2030) for both average annual figures as well as for seasonal 
variations. Stakeholder meetings may be used to check and validate the general trends, particularly 
if there is a degree of uncertainty in the available information . The city may decide to commission 
additional local research as part of its Resilience Strategy if it is not satisfied with the quality of 
available data. 

Background:
Following are guidelines for the collection of climate data, based on the ICLEI USA User Guide “The 
Adaptation Database and Planning Tool (ADAPT) User Guide”. 

The first step is to review local and regional information about how the climate is already changing, 
as well as how it is expected to change in the future.  This includes identifying the amount of change 
expected in climate, such as average temperature, precipitation, sea level rise, wind speeds and 
extreme events that are projected in your area.  The amount of change expected will typically be 
expressed as a range that could increase or decrease by a specified future date, relative to the 
average for a given baseline set of years.  When identifying changes, to the extent possible, avoid 
using only one projection of future climate (e.g. 30 cm sea level rise ) and instead include a range 
(e.g. 25 to 40 cm of sea level rise by 2030 compared to 1980-1999 baseline years).

Projections for certain climate changes, such as precipitation, may show a range in the amount of 
expected change that includes both a potential decrease and increase, either due to uncertainty in 
the projection or seasonal variability, where one season is expected to see an increase and another 
season will see a decrease.  Where possible collect information about how climate will change by 
season , such as “average summer precipitation” and “average winter precipitation” instead of 
“average yearly precipitation”.

When reviewing sources of scientific data, be cautious about reading isolated studies and avoid 
including reports that have not been extensively peer-reviewed by top-level, credible scientists.  
In addition to the regional summaries provided by the sources above, you should contact nearby 
governments and universities, state or provincial climate change websites, environmental 
agencies, and local  community groups or NGOs that may either have scientific projections for your 
particular local area, or have compiled research on climate change that you can use.

Find local level climate data

Use stakeholder meetings to 
validate the general trends

Avoid using only one projection 
of future climate and instead 

include a range

Where possible collect 
information about how climate 

will change by season

Contact local organisations 
that have done climate change 

research
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CLIMATE EXPOSURE: PROJECTIONS & SCENARIOS
Tool 2.1

Exercise 1
Try to collect as much of the following information as possible, then summarise it in the template 
provided in Table 1 (an example is given to facilitate this process):

• Name of changing climate condition [e.g. increase or decrease in temperature, precipitation, 
extreme weather events]
• Amount of expected change (expressed as a range) including baseline year(s) from which 
change is measured and the planning horizon year by which change will have occurred
• Geographical area for which climate projection is relevant [e.g. a specific region or location]
• Greenhouse gas emissions scenario for which the projection is relevant [e.g. high and/or low 
emission scenarios]
• Extent of variability (seasonal, El Nino, La Nina etc) [expected variations across seasons e.g. 
between summer and winter, and/or events e.g. high precipitation followed by drought]
• Level of confidence [degree of certainty (less certain / more certain) of the projected change]
• Source of information [this would need to be specified for the supplementary local assessments]

Collect information about all 
these categories

Please Note: Some specialist assistance may be required for this process and can be sought from 
universities or research institutes in the area.
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Table 1:	Climate Data Summary – Example and Exercise

Changing 
Climate

Condition

Green-
house Gas 
Emissions 
Scenario

Assessments Extent of 
Variability

Amount of
Expected Change
(include baseline 

and planning 
horizon years)

Level
of

Confidence

Geographical 
Area

Source(s)

Precipitation 
change 

Temperature 
change 

Extreme 
events 
(please 
specify the 
event)

Sea Level 
Rise

Regional 
Assessments 

Regional 
Assessments 

Regional 
Assessments 

Regional 
Assessments 

e.g. 1268±225.2 
mm to 1604±175.2
mm
Baseline year: 1970
Horizon year: 2030

Himalayan 
Region (Western 
Himalayas 
constituting of 
Jammu and
Kashmir, 
Uttarakhand 
and Himachal 
Pradesh)

Overall increase 
in rainfall. June, 
July, August, 
September - 
12mm 
January, February 
-  5mm 
October, 
November and 
December

High 4x4 
Assessment 
report by 
Government 
of India (GoI) 
Assessment 
report by 
Government 
of India (GoI)

A1B scenario,  
IPCC

Supplementary 
Local 
Assessments

Supplementary 
Local 
Assessments

Supplementary 
Local 
Assessments

Supplementary 
Local 
Assessments
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SECTION B ANALYSIS AND SCENARIO(S)

Exercise 2: Climate Scenario Statements

Step 1
Analyse the results of the data collection to determine whether there is a consistent set of 
projections, particularly around the most significant direct climate impacts e.g. precipitation 
patterns, temperature rise, sea level rise, extreme weather events .  

If the results for a particular ‘changing climate condition’ are quite consistent for both the regional 
and local assessments, a single Climate Scenario Summary Statement can be written for that 
climate condition. However, if there are significant variations in the projections, you may need to 
develop two separate Climate Scenario Summary Statements for each of the assessments.  Some 
specialist assistance may also be required for this process.

Step 2
Now , write one or more Climate Scenario Statements for the changing climate conditions identified 
in the table above. A Scenario Statements can be framed in the following manner:

“There is a... <insert information from ‘level of confidence’ i.e. degree of certainty>... of a...<insert 
information from ‘amount of expected change’ i.e. the range>...in the...<insert information from 
‘changing climate condition’>...in the...<insert information from ‘geographical area’>...by the 
year...<insert information on the planning horizon year from ‘amount of expected change’ column>. 
The projected change is expected to...<insert information from ‘extent of variability’>.” 

Write your Climate Scenario 
statement(s) 

CLIMATE EXPOSURE: PROJECTIONS & SCENARIOS
Tool 2.1

Is there any consistent set of 
projections in the data analysis?

Please Note: that it is critical to ensure that the time horizons for the projections are similar.  If 
the time horizons from the various data sources are different, it will be necessary to interpolate or 
extrapolate some of the data to a consistent year in order to assess the consistency or inconsistency 
of the projections. 
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CLIMATE EXPOSURE: PROJECTIONS & SCENARIOS
Tool 2.1

Table 2:	Climate Scenario Statement – Example and Exercise

References
Kajian Risiko dan Adatasi Perubahan Iklim (KRAPI)
http://www.paklim.org/library/publications/?category=24

Climate Change and India: A 4 x 4 Assessment. A Sectoral and Regional Analysis for 2030
 http://moef.nic.in/downloads/public-information/fin-rpt-incca.pdf

The Adaptation Database and Planning Tool (ADAPT) User Guide, ICLEI USA, November 2010
 www.icleiusa.org

Changing 
Climate

Conditions

Assessments Climate Scenario Summary 
Statements

Precipitation 
change 

Temperature 
change 

Extreme 
events 
(please 
specify the 
event)

Sea Level 
Rise

Regional Assessments (4x4 
Assessment report by GoI)

Regional Assessments (4x4 
Assessment report by GoI)

Regional Assessments (4x4 
Assessment report by GoI)

Regional Assessments (4x4 
Assessment report by GoI)

Supplementary Local 
Assessments

Supplementary Local 
Assessments

Supplementary Local 
Assessments

Supplementary Local 
Assessments

e.g. There is a high level of confidence of an expected change of 1268±225.2 mm 
to 1604±175.2 mm in the precipitation in the Himalayan Region by the year 2030. 
The projected change is expected to be maximum in monsoon months - June, July, 
August and September, and minimum in October, November and December.

Have you:

Looked for and collected local level climate data?

Analysed the collected data to determine whether there are consistent sets 
of projections?

Written your Climate Scenario Statements?

Consulted climate experts during the process?



URBAN
SYSTEMS 
ANALYSIS
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Implementing  this tool is a critical step in the ICLEI ACCCRN 
climate resilience building process as proposed actions or 
resilience strategies would be based on its outcomes. It examines 
urban systems to identify fragile systems and how they would be 
impacted by climate change.

This tool provides guidance for working through two exercises:

1. Identification of “fragile urban systems” i.e. the systems or 
services in your city which are already weak or under great 
pressure.
2. Assessment of the impact of climate change on these fragile 
systems. 

This analysis is based on the “Urban Climate Resilience Planning 
Framework (UCRPF)” developed by ISET as part of the original 
ACCCRN program. 

TOOL 2.2 How to undertake the Urban Analysis:
The city Climate Core Team should conduct a 1-2 day 
workshop to identify the unique and potentially fragile features 
of their city, and the likely impacts of projected climate change, 
following the UCRPF.  The recommended steps are to:

• Identify critical and potentially fragile urban systems 
• Hypothesise which of these systems may be most impacted 
by climate change  

It is important to incorporate the views of the stakeholder 
group as well. There are two ways in which the Core Team 
could proceed:
 
1. The Core Team undertakes this exercise on their own and 
then shares the results with the Stakeholder Group for their 
feedback and support
2. This entire urban analysis exercise is undertaken jointly 
by the Core Team and the Stakeholder Group as part of a 
consultation process.

The 2nd option is recommended as it is more participatory and 
inclusive and allows for greater interactions and discussions 
between the Core Team and the Stakeholder Group. It allows 
for the same issue (e.g. identification of fragile urban systems 
– Exercise 1 below) to be discussed by different groups of 
heterogeneous participants and it provides an  opportunity to 
every group to present their results and to debate and finalise 
together the outputs of the exercise. This approach can be 
repeated for other exercises as well as for generating greater 
discussions and consensus building on the outputs. 

Please follow the instructions and steps listed for each of the 
exercises. Please note that it may be worth hiring the services 
of a workshop facilitator to conduct this workshop.

ICLEI ACCCRN PROCESS60

 Please refer to Reference Tool 7 
for the theoretical background of 
this framework. 
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URBAN SYSTEMS ANALYSIS
Tool 2.2

Urban systems may include ‘core systems’, such as water and food, essential for the survival 
of the city, and ‘secondary systems’ such as education and social services, which rely on the 
core services.  The table below provides an indicative menu of both core and higher level urban 
systems to assist your thinking. Note that this list is not complete, so please do not be limited by it 
and add and/or select systems that you feel are appropriate for your city. 

Example 1: Indicative checklist of core and secondary urban systems:

EXERCISE 1: FRAGILE URBAN SYSTEMS
In order to identify the fragile urban systems in your city complete the Excercise 1 Matrix by 
following these steps: 

Step 1
First, identify the systems or services in your city which are already failing or are under great 
pressure .  

To help identify fragile systems you could refer to: 

• Exercises 1 & 2 of Tool 1.3 in which the sectors that are perceived as being impacted by climate 
change have already been discussed and listed by the Core Team. This can provide a very useful 
starting point for discussions on identifying the fragile urban systems in the city 
• The highest priorities in your city’s development / master plan.  If your city has a City Development 
Plan (CDP), use this as a reference document
• Your city’s /district’s disaster management plan
• The key concerns raised with the city administration by the community and private sector

Step 2 
Define  your reasons for rating them as fragile. You can use your own reasons for this assessment, 
and can also refer to some “resilience characteristics” as follows:  

Achieving resilience is the desired outcome of developing and maintaining urban systems. 
Resilience is defined as:

“The ability of a social or ecological system to absorb disturbances while retaining the same basic 
structure and ways of functioning, the capacity for self-organisation, and the capacity to adapt to 
stress and change (IPCC, 2007 ).”

Therefore, in the case of the ICLEI ACCCRN Process, resilient urban systems would be those 
urban systems that are able to maintain their functions and linkages in the face of climate 
stresses and changes. 

Some Core Urban Systems

• Ecosystems
• Land
• Energy
• Water
• Food
• Shelter
• Transport
• Communications

Some Secondary Urban Systems

• Health care
• Education
• Finance
• Markets
• Sanitation
• Community services
• Public security
• Taxation

Source: Adapted from ISET, 2011

Which systems in your city are 
already failing or under great 

pressure?

Why are these systems fragile?

To help identify fragile 
systems you could refer to: 
exercises 1 & 2 of Tool 1.3
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URBAN SYSTEMS ANALYSIS
Tool 2.2

Characteristics of resilient systems include:

Flexibility and diversity - mix of multiple options, key assets and functions are distributed or 
decentralised, not all affected by a single event 
Example: A network of hospitals rather than a single, central hospital

Redundancy - alternatives / back-up systems / contingency plans, capacity for contingency 
situations, multiple pathways and options for service delivery in case one or several options fail
Example: Hospitals and emergency communications facilities have shared or linked backup electrical 
generators 

Safe failure – ability to absorb sudden shocks or slow onset stress so as to avoid catastrophic 
failure
Example: Dikes are designed so that if their capacity is exceeded, they fail in predictable ways, channelling 
flooding away from populated areas 

Step 3
Next , consider the existing and anticipated problems caused by the fragility of the urban systems. 
The guiding question here is: ‘How does the fragility of this urban system impact other functions, 
systems and services in your city?’ 

Step 4	
Now , define who is responsible. Is it part of the city government’s function, the responsibility of 
another entity, or a shared responsibility? This will help define whether the city government will 
be able to take action to reduce the fragility of this system solely on its own, in collaboration with 
another department, or will need to approach some other entity with the issue and the proposed 
action.

Step 5	
Finally, based on the information generated in the earlier steps, write a summary ‘fragility 
statement’. (Please see the example in italics in Table 1 on the next page)

How will their fragility impact 
other systems?

Who is responsible for these 
systems?

And now write your fragility 
statement
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Table 1: Identifying Fragile Urban Systems - Example and Exercise 

Urban
system

e.g. Water 
supply

Why is it critical or fragile?

Flexibility & Diversity: 
Traditional water sources 
have been lost due to the 
urbanisation process and the 
city depends on centralised 
pumping systems that transport 
water from significant distances 
to the city. Supply cannot meet 
the growing demand

Redundancy: Alternatives 
usually include water supplied 
by tankers (trucks). Given 
the mountainous region this 
limits access of these trucks 
in addition to them being an 
expensive and polluting fallback 
option

Safe failure: in case of a 
disruption in water supply, 
individual households have to 
fend for themselves. One of the 
systems is over a 100 years old

• Disruption of water supply to 
citizens

• Additional financial burden 
on individual households to 
purchase water from water 
tankers

• Water shortage adversely 
impacts the tourism industry

• Increased pollution and 
emissions from the plying of 
water tankers

The water supply 
system in the city is old 
and largely dependent 
on transporting water 
over large distances, 
whereby even minor 
disruptions cause 
significant shortages in 
the city in the face of an 
ever growing demand; 
alternatives are not cost 
effective or sustainable.  

Shared with the 
Irrigation & Public 
Health Department

What are the existing and 
anticipated problems 

caused by the fragility of 
this system?

Part of city 
function 

(Completely / 
Shared / No)

Fragility 
statement
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EXERCISE 2: CLIMATE IMPACTS ON FRAGILE URBAN SYSTEMS 
To assess the impacts of climate change on the fragile systems identified in the Exercise 1 above, 
complete the Exercise 2 Matrix by following these steps:

Step 1: 
Begin with the fragile systems identified in your city and the corresponding fragility statements 
developed in Exercise 1 above 

Step 2: 
Next, consider the Climate Scenario Summaries developed in Tool 2.1.  The question to answer 
here is:
‘How might the projected climate changes impact on the critical / fragile systems that you have identified 
in Exercise 1?’  

For this, each Fragility Statement developed in Table 1 above should be listed. Remember that in 
most cases climate change may threaten or weaken a system (e.g. already poor drainage systems 
may be worse off in case of expected increases in precipitation), but in a few others climate change 
may bring benefits to the system too (e.g. water supply systems that are inadequate due to lack of 
availability of sufficient water resources could benefit from an expected increase in precipitation). 

Step 3: 
Finally, based on the information generated in the earlier steps, write a ‘climate risk statement’ 
that identifies the characteristics of the fragile system and the potential climate impacts on this 
system . 

How will climate change impact 
these fragile systems?

Take the fragile systems and 
fragility statements from 
Exercise 1

Write your climate risk 
statement

Please Note: If you have generated a second climate scenario summary, you will need to undertake 
the Fragile Urban Systems analysis a second time. Then compare the two lists of fragile systems: the 
systems which feature in both lists will obviously be high priorities for the city.  Any system identified 
as fragile under one climate scenario, but less fragile in the second scenario, may be given a lower 
priority for action, or may be targeted for further study and analysis. This process of comparing the 
two lists of fragile systems is illustrated in the flow chart below .
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Flow chart Showing Scenario Treatment

Climate Data

Inconsistent

Climate
Scenario 1 

Urban System 
Analysis 1

Fragile Systems 1

Reconciliation

Fragile Systems 2

Urban System 
Analysis 2

Climate
Scenario 2 

Consistent

Urban System 
Analysis

Fragile Systems

Refer to climate scientists if confusing results 
arrive/for efficient time zone

When the results from national 
assessments and supplementary 

assessments do not match

The results of 
supplementary 
assessments

Combine the results derived from 
various scenarios

The results of 
supplementary 
assessments

When the results from national 
assessments and supplementary 

assessments do match

Please note: There can be more 
than two scenarios arising from 
the varied results of the national 
and supplementary assessment
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Table 2(a)  Climate Impacts on Fragile Urban Systems (Climate Scenario 1) - Example and Exercise

Urban system Fragility
statement

Climate fragility 
statement

Climate fragility 
statement

Climate fragility 
statement

Climate fragility 
statement

Climate risk 1: 
e.g. Increased 
precipitation

Climate risk 2:  
e.g. Increased 
temperatures

Climate risk 3: Climate risk 4:

e.g. Water supply Increased
precipitation
disrupts /
damages water 
supply
infrastructure

Increased 
precipitation 
can cause water 
to freeze in the 
pipelines

e.g. Water supplyThe water supply 
system in the 
city is old and 
largely dependent 
on transporting 
water over 
large distances, 
whereby even 
minor disruptions 
cause significant 
shortages in 
the city in the 
face of an ever 
growing demand; 
alternatives are not 
cost effective or 
sustainable

Increased 
temperatures will 
lead to 
increased 
demand for water 
thereby posing 
additional stress on 
the supply system

e.g. Water supply

URBAN SYSTEMS ANALYSIS
Tool 2.2
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Table 2(b)  Climate Impacts on Fragile Urban Systems (if needed for a second Climate Scenario) - Exercise

Urban system Fragility
statement

Climate fragility 
statement

Climate fragility 
statement

Climate fragility 
statement

Climate fragility 
statement

Climate risk 1: 
eg. Increased 
precipitation

Climate risk 2:  Climate risk 3: Climate risk 4:

e.g. Water supply

References
Moench, M., S. Tyler, et al. (2011), Catalyzing Urban Climate Resilience: applying resilience 
Concepts to Planning Practice in the aCCCrn Program (2009–2011), The Institute for Social and 
Environmental Transition, International, Boulder, CO, USA

URBAN SYSTEMS ANALYSIS
Tool 2.2

Have you:

Identified your fragile urban systems, the reasons for their fragility and the entities 
responsible for these systems?

Looked into how this fragility will impact other systems?

Written your Fragility Statements?

Analysed how climate change will impact these systems?

Written your Climate Risk Statements?

Involved or at least consulted the Stakeholder Group in your Urban Systems Analysis?
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RISK
ASSESSMENT

ICLEI ACCCRN Process

At  the end of Tool 2.2 you produced a series of Climate Risk 
Statements.  Tool 2.3 now helps you to prioritize these risks using 
a Risk Assessment methodology.  

Note that this exercise can be quite subjective as it depends on the 
opinions and personal experiences of participants.  Therefore it is 
recommended to conduct the risk assessment with a broad group 
of city representatives and preferably to repeat the exercise with 
the Stakeholder Group to validate the priorities.

TOOL 2.3 How to undertake the Risk Assessment:
It is recommended that the city Climate Core Team conducts 
a workshop to assess the status of climate risk statements. It 
is important to incorporate the views of the stakeholder group 
as well. There are two ways in which the Core Team could 
proceed:
 
1. The Core Team undertakes this exercise on their own and 
then shares the results with the Stakeholder Group for their 
feedback and support
2. This entire Risk Assessment exercise is undertaken jointly 
by the Core Team and the Stakeholder Group as part of a 
consultation process

The 2nd option is recommended as it is more participatory and 
inclusive and allows for greater interactions and discussions 
between the Core Team and the Stakeholder Group. It allows 
for the same issue (e.g. each group assign a Risk Score – 
described below – for each of the climate risk statements) to be 
discussed by different groups of heterogeneous participants, 
and it provides an opportunity to every group to present their 
results and debate and finalise together the outputs of the 
exercise. This approach will help generate greater discussions 
and consensus building on the final risk prioritization of the 
climate risk statements.
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EXERCISE 1: PRIORITIZATION OF THE CLIMATE RISKS
Step 1 	
Transfer the Climate Risk Statements (taken from table 2, in Tool 2.2) to the first column of Table 
1 below .  

Step 2 
Now, assess the likelihood of each risk occurring and assign a score from 1 to 5, using Example 
1 for guidance. It is recommended that you refer back to the ‘Level of Confidence’ that has been 
assigned to each of the identified climate change conditions in Table 1 of Tool 2.1. For example, if 
the projected increase in precipitation has a ‘high’ level of confidence, its likelihood of occurrence 
is higher.

Example 1: Likelihood Rating and Scoring

Step 3  	
Next, for each climate risk, assess the consequence, or impact, if the risk does occur.  Consequences 
can range from Catastrophic to Moderate to Insignificant.  Assign a score from 1 to 5 for each 
risk where 5 is Catastrophic and 1 is Insignificant. Example 2 shows one way of assessing the 
different consequence rating, using “Impact on the System” and “Impact on the City Government” 
as measures.  However, you may also write your own Consequence Scale. 

A particular focus of this assessment is to identify systems failures which could have direct 
and serious impacts on the poorest and most vulnerable groups in the city.  Therefore it is 
recommended to consider the impacts on both, the system as well as the poor and vulnerable, 
while deciding on the Consequence ratings of each of the climate risks.

What is the likelihood of each 
risk occurring? Check table 1 of 

Tool 2.1 for help

What type of consequence 
would this risk have?

Look again at your Climate Risk 
Statements (Tool 2.2)

Likelihood rating Description Score

Almost certain

Likely

Possible

Unlikely

Rare

5

4

3

2

1

Is highly likely to occur, could occur several 
times per year. Likelihood probably greater 
than 50%

Reasonable likelihood, may arise once per 
year. Likelihood  50/50 chance

May occur, perhaps once in 10 years 
Likelihood  less than 50% but still quite high

Unlikely but should still be considered,  may 
arise once in 10 to 25 years

Likelihood probability significantly greater than 
zero. Unlikely in foreseeable future – negligible 
probability
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Reference Tool 9	 Local 
Government Strategic Priorities 
Consequence Scale

Another way of assessing the 
consequence of a climate risk on 
the city is to measure it against the 
city’s strategic priorities.  Reference 
Tool 9 provides an example. 
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Example 2: Consequence Rating and Scoring 

Impact on system Impact on poor and vulnerable
Consequence 

rating Score

Catastrophic

Major

Moderate

Minor

Insignificant

System fails completely and is unable 
to deliver critical services,, may lead to 
failure of other connected systems

Serious impact on the system’s ability 
to deliver critical services, however not 
complete system failure; 

System experiences significant prob-
lems, but still able to deliver some 
degree of service 

Some minor problems experienced, 
reducing effective service delivery, 
possibly affecting certain other systems 
or groups

Minimal impact on system – may require 
some review or repair, but still able to 
function

Severe impacts on poor and vulnerable 
groups in the city leading to situations of 
extreme destitution 

Loss of confidence and criticism in city 
government; ability to achieve city vision 
and mission seriously affected;

Significant  impacts on poor and vul-
nerable groups in the city that seriously 
affects their lives and livelihoods

Moderate impacts on the lives and liveli-
hoods of the poor and vulnerable groups 
in the city

Minor impacts on the lives and liveli-
hoods of the poor and vulnerable groups 
in the city

Minimal impacts on the lives and liveli-
hoods of the poor and vulnerable groups 
in the city

5

4

3

2

1

Step 4 	
Having assigned a ‘Likelihood’ and ‘Consequence’ score to each of the identified climate risks, now 
multiply both these values (score from step 2 and score from step 3) to arrive at the ‘Risk Score’ 
for each Climate Risk Statement.

Step 5 
Finally, for each of the climate risk statement, assess their Risk Status based on their respective 
Risk Scores. Please refer to the ‘Summary of Risk Matrix’ in Example 4 for assessing the risk 
status. 

Now assess the risk status of 
each risk statement

What is the risk score for each 
Climate Risk Statement?
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Climate Risk Statements                                                                        Likelihood          Consequence          Risk score          Risk Status 
                                                                                                                                                                                                (Likelihood x
                                                                                                                                                                                                     Consequence)

Increased precipitation disrupts/ damages water supply 
infrastructure 

Increased precipitation can cause water to freeze in the 
pipelines

Increased temperatures will lead to increased demand for 
water thereby posing additional stress on the supply system

4 

4 

3 

4 

4 

3 

16 

16 

9 

High

High

Medium

Example 4: Summary of a Risk Matrix

Please see the example provided in the Exercise table 1 below. The climate risk statements are taken from Tool 2.2 and used as an 
example; you can fill out a similar table with your own statements and scoring. 

Table 1: Prioritisation of Climate Risks – Example and Exercise

Likelihood

Moderate

Consequences

Insignificant MajorMinor Catastrophic

Almost certain

Likely

Possible

Unlikely

Rare

Medium (RS* = 5)

Low (RS = 4)

Low (RS = 3)

Low (RS = 2)

Low (RS = 1)

High (RS = 15)

High (RS = 12)

Medium (RS = 9)

Medium (RS = 6)

Low (RS = 3)

Extreme (RS = 25)

Extreme (RS = 20)

High (RS = 15)

Medium (RS = 10)

Medium (RS = 5)

Medium (RS = 10)

Medium (RS = 8)

Medium (RS = 6)

Low (RS = 4)

Low (RS = 2)

Extreme (RS = 20)

High (RS = 16)

High (RS = 12)

Medium (RS = 8)

Low (RS = 4)

*RS: Risk Score

Please Note: if more than one climate scenarios were used in Exercise 1 then this risk assessment would need to be repeated .

Have you:

Considered the likelihood of each climate risk?

Foreseen the consequences these risks would have?

Assessed the risk status of each risk statement? 

Involved or at least consulted the Stakeholder Group in your Risk Assessment?
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ENGAGEMENT 
CHECKLIST 

ICLEI ACCCRN Process

As you work through the process you may discover issues and 
groups of stakeholders that were not identified initially.  There will 
be points where you need to consult external groups and points 
where you need to report back to the city decision makers. It is 
therefore essential that you revisit and review at key points the 
engagement decisions taken so far and ensure that the support 
structures for the climate planning are in place. This is also the 
moment to identify key messages to be shared without the larger 
group.

PHASE 2



ENGAGEMENT CHECKLIST 
Phase 2

ICLEI ACCCRN PROCESS 73

Categories Questions Yes/No Comments

Climate core team

External stakeholders

Consultation

Communication

Reporting

Do you have the relevant 
department/sectoral 
representatives, do you 
need to invite additional 
people if you have identified 
unexpected climate impacts 
or actions? 

Do you have the key 
stakeholders to cover each 
climate issue or action 
identified? 

Have you reached a point 
where you need to consult 
widely, or consult particular 
groups?

Is there new information, 
or better understanding of 
climate issues, which should 
now be communicated?  If so, 
to whom, how and when? 

Is it time to report back to the 
Mayor, or council, or senior 
management (or another key 
stakeholder?)

(You might have 
to go back to Tool 
1.1 and update the 
information)

(You might have 
to go back to Tool 
1.2 and update the 
information)

(You might have 
to go back to Tool 
1.5 and update the 
information)

Notes
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VULNERABILITIES 
ASSESSMENT

Overview of Phase 3

ICLEI ACCCRN Process

In this Phase you will produce maps of the high priority climate risks 
and assess the impact on the most vulnerable groups of people, 
then analyse the adaptive capacity of the urban systems involved.  
The final tool will assist you in collating all this information and 
identifying gaps in data. 

The tools included in Phase 3 and their corresponding objectives 
are:

Tool 3.1: Vulnerable Places and People – to identify areas in the 
city that are vulnerable to the expected climate impacts and assess 
the adaptive capacities of the affected actors 

Tool 3.2: Assessing the Adaptive Capacities of Urban Systems 
– to determine the adaptive capacity of the fragile urban systems in 
terms of economic, technology/ infrastructure, governance, social, 
and ecosystem perspectives 

Tool 3.3: Data Gap Analysis - to identify data gaps for each fragile 
urban system that would need to be addressed to improve the 
planning process 

In Phase 2 it was necessary to work through the tools in a specific 
sequence.  However, in this phase you can work through the first 
two tools in either order, or you could undertake the two tools 
in parallel with separate working groups.  The results are then 
collated in Tool 3.3.

TOOL 3.0

How to undertake the Vulnerabilities Assessment:
The city Climate Core Team should conduct a 1 – 1.5 days 
workshop in which Tool 3.1, Tool 3.2 and Tool 3.3 can be 
implemented. The outputs of this workshop would be:

• The vulnerable areas of the city are mapped and the actors/
stakeholders who may be most affected or who may be 
instrumental in responses are identified (Output of Tool 3.1)
• The adaptive capacity of the fragile urban systems 
is determined and the outputs of Tools 3.1 and 3.2 are 
consolidated (Output of Tool 3.2)
• Data gaps of the fragile urban systems are identified 
(Output of Tool 3.3) 

It is important to incorporate the views of the stakeholder 
group as well. There are two ways in which the Core Team 
could proceed:
 
1. The Core Team undertakes each exercise (Tool 3.1, Tool 3.2 
and Tool 3.3.) on their own and then shares the results with 
the Stakeholder Group for their feedback and support
2. This entire Vulnerabilities Assessment exercise is 
undertaken jointly by the Core Team and the Stakeholder 
Group as part of a consultation process.

The 2nd option is recommended as it is more participatory and 
inclusive and allows for greater interactions and discussions 
between the Core Team and the Stakeholder Group. It allows 
for the same issue (e.g. mapping of areas vulnerable to the 
prioritised climate impacts) to be discussed by different groups 
of heterogeneous participants and it provides an opportunity to 
every group to present their results and to debate and finalise 
together the outputs of the exercise. This approach can be 
repeated for all exercises as well as for generating greater 
discussions and consensus building on the outputs. 
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VULNERABLE
PLACES AND
PEOPLE

ICLEI ACCCRN Process

In  this Tool you will produce maps showing the distribution of 
the high priority climate risks across the city area.  You will then 
identify which social groups are most vulnerable to the impact of 
these climate risks and assess their capacities to respond to these 
impacts. 

TOOL 3.1

How to undertake the Vulnerable Places and People 
Assessment
It is suggested that the Climate Core Team meet to discuss 
and collectively undertake this exercise. This can be done only 
for Tool 3.1 or together with Tool 3.2 and Tool 3.3. The results 
should then be shared with the Stakeholder Group for their 
feedback and support.

Ideally the entire Vulnerabilities Assessment exercise should 
be undertaken jointly by the Core Team and the Stakeholder 
Group as part of a consultation process.
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EXERCISE 1: MAPPING OF EXISTING VULNERABLE AREAS
In this exercise, the vulnerable areas under each fragile urban system in the city are identified. This 
can be done using hard copies of the city ward map and different colours representing different 
climate risk statements. For example, for the climate risk statement: ‘Increased precipitation 
disrupts / damages water supply infrastructure’, the areas (or wards) most likely to be affected can 
be coloured blue (instead of colours, symbols can be used if more than one risk affect the same 
ward) on a map of the city that shows the boundaries of the smaller administrative units that the 
city is divided into (e.g. a Ward Map). Similarly, other areas / wards within the city affected by each 
of the other identified climate risks can be marked by using a different colour for each one. This 
will help develop a fair idea of the wards / areas where the identified climate risks, and therefore 
the corresponding fragile urban systems, are most critical. 

Example of Climate Risks map from Bhubaneswar

Before undertaking this exercise,make sure to identify those wards / areas that have higher 
populations of poor or marginalised groups (e.g. slums, temporary settlements) and to consider 
the impacts on these areas during the mapping exercise.
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Below you find some further steps to follow:

Step 1:	
Refer to the climate risk statements (and fragile urban systems) that were prioritised in Tool 
2.3, i.e. those that have been allotted an Extreme, High (or in some cases Medium) risk score. 
Categorise these according to their corresponding fragile urban systems (refer to exercise 2 in 
tool 2.2) and assign a colour to each of these climate risk statements.

Step 2:	
For the first climate risk, identify the areas / wards of your city that will be most affected and mark 
them with the appropriate colour. Then repeat this process for each climate risk.  You may want to 
use separate maps for each of the fragile urban systems for clarity.

Step 3:
In this step you will identify which areas of the cities are impacted by the greatest number of high 
climate risks. These areas will represent the Vulnerability Hotspots in the city. To identify the 
vulnerability hotspots, overlay each of the climate risk maps. 

For example, assume that the city has identified 5 high climate risks. If an area of the city is 
impacted by all 5 high climate risks, it would be a vulnerability hotspot of the city. Next, the affected 
areas can be ranked according to the number of risks they are exposed to. 

This mapping of the ‘vulnerability hotspots’ of the city will help easily (and visually) determine 
the areas within the city that are most vulnerable and which would probably require immediate 
attention.

Example of Vulnerability Hotspots map from Bhubaneswar

Look back at the prioritised risk 
statements of Tool 2.3

Which areas in your city will be 
most affected by these risks?

Which areas in the city are 
impacted by most climate risks?

Vulnerability Hotspots

Wards impacted by three 
fragile urban systems 

Wards impacted by all 
four fragile urban systems 

Wards impacted by two 
fragile urban systems 

Wards impacted by one 
fragile urban systems 

17

28

29

60

59

30

27

18

10

16

19
15

20

26
25

34

33

45

46

47

53

58 55

56

54

52
51

49
48

43

38

37

22

14

13
6

21

39

42

41

40

5

3

4

50

44

36

23

57

35

24

32

31

11

8
9

1
2

7

12

Vulnerabilities
�  Impacted by water logging and 

disrupted infrastructure
� Impacted by shortage of water
� Prone to health and fire risks 
� Prone to shortage of power 

supply and disrupted 
infrastructure 

� Faces additional stress on 
ecosystems

Population impacted
� Commercial units 
� Urban residents 
� Slum residents
� Women
� Children and elderly people
� Industries
� Institutions 
� Students
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EXERCISE 2:  ANALYSIS OF ADAPTIVE CAPACITY OF URBAN ACTORS
The exercise draws on the Urban Climate Resilience Planning Framework (UCRPF) introduced in 
Tool 2.2.

Some Background:
Actors (i.e. individuals, households and public/private sector organisations), play a critical role 
towards building urban resilience. Their ability to contribute to resilience and adaptation is broadly 
dependent on the following three key capacities:

Capacity to organise and respond - the capacity to organise and re-organise in response to 
threat or disruption.
Example: slum communities residing in a flood prone area have received training on how to purify water 
for drinking and maintaining hygienic conditions to prevent the outbreak of post flood diseases. Or, 
trained Search and Rescue Teams  exist within the community that can respond effectively during floods.

Resources – access to the resources necessary to respond (manpower, technology, funds)
Example: slum communities residing in a flood prone area have been provided with water filters that will 
ensure that they have safe drinking water even during flood situations. Or, the Search and Rescue Teams 
have the necessary equipment and medicines.

Access to information – availability of data and information necessary to develop effective 
plans and actions and to improve responses to disruptions.
Example: slum communities residing in a flood prone area have access to improved information that can 
be locally managed e.g. Early Warning Systems, which would enable them to respond more effectively. 
Or, regular refresher and updating training courses for the members of the Search and Rescue Teams.

The combination of these three characteristics would help determine the adaptive capacity of 
each of the urban actors.

Exercise 2 helps to identify the specific key actors in the identified vulnerable areas. In Exercise 
1, you have identified the most vulnerable areas/wards in your city; now you will identify the key 
groups of people in each high risk locality. 

The Actors analysis can be used to identify:

1. How different categories of actors relate to different systems (who, what, where, why)
2. What categories of actors may be missing
3. Groups of actors that may be disempowered, lacking in capacities or otherwise marginalised

Check Reference Tool 7 for more 
information on the Urban Climate 

Resilience Planning Framework 
(UCRPF) 



ICLEI ACCCRN PROCESS80

VULNERABLE PLACES AND PEOPLE
Tool 3.1

Step 1 :
Select the Climate Risk from the maps in Exercise 1 above

Step 2 :
For each Climate Risk, list the key actors involved – those affected by, and those who have control 
over, the system. 

For example, Ward XY is vulnerable to flooding, so the specific actors affected could be
• the residents, specifically the poor households in the area
• a hospital 
• a NGO working on education in this ward
• street vendors 

The specific actors who may have control may be the Department of Water Resources or the 
Department of Sewerage and Drainage.

When defining the actors, you are encouraged to be as specific as possible. Therefore, rather 
than mentioning ‘residents of Ward XY’ you should try and specify‘women, children and elderly 
in Slum 22’. The more precise you are in determining the actors, the simpler it would be to 
target and organise an effective response. 

Step 3 :	
We now need to double-check that we have not overlooked any groups of poor or vulnerable people 
who may not be located in the Hotspots identified in Exercise 1.  This is very important as there 
may be groups which could be affected by a particular climate risk which has not been identified 
through the urban systems analysis in Phase 2.  Look particularly for poor communities, or groups 
which may already be struggling and for whom a small change in temperature, rainfall, flooding 
could be a tipping point which causes high vulnerability.

Any groups identified in this step should be added to Table 1 below.

Step 4 :
Using Table 1 below, rate the actors against the three criteria - Capacity to Organise and Respond, 
Resources, and Access to Information. For each of the criteria you need to determine whether the 
capacity of a particular actor is Low, Medium or High, and accordingly assign the corresponding 
score as indicated in the table.

Look back at your Climate Risks 
Map

Rate the actors’ capacities

What are the key actors
involved?

Are you sure you have identified 
all vulnerable people? Check 
again!
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Table 1: Actors’ Capacities Rating and Scoring - Example

Step 4:
Finally, for each actor calculate their ‘Adaptive Capacity Score’ by multiplying the scores allocated 
to each of the 3 characteristics.

Step 5:
Based on the Adaptive Capacity Scores of each of the actors, for a particular fragile system, you 
can determine which actors have a High, Medium and Low adaptive capacity. Refer to Table 2 to 
help you assess the level of adaptive capacity of each of the actors.

Key Capacities of Actors

Capacity to Organise and Respond

Resources

Access to Information

Score

Low capacity to organise and re-organise in response to threat or disruption

Medium capacity to organise and re-organise in response to threat or 
disruption

High capacity to organise and re-organise in response to threat or disruption

Low access to the resources necessary to respond (manpower, technology, 
funds)

Medium access to the resources necessary to respond (manpower, 
technology, funds)

High access to the resources necessary to respond (manpower, technology, 
funds)

Low availability of data and information necessary to develop effective plans 
and actions and to improve responses to disruptions

Medium availability of data and information necessary to develop effective 
plans and actions and to improve responses to disruptions

High availability of data and information necessary to develop effective plans 
and actions and to improve responses to disruptions

1

2

3

1

2

3

1

2

3

Assess the level of adaptive 
capacity of each actor

What is the Adaptive Capacity 
Score of each actor?

ICLEI ACCCRN PROCESS 81
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VULNERABLE PLACES AND PEOPLE
Tool 3.1

Table 2: Levels of Adaptive Capacity of Urban Actors

Actors having a ‘Low’ level of adaptive capacity would be those that would need to be 
specifically targeted in the actions (or resilience strategies) that are undertaken to reduce the 
fragility of the identified urban system. 

Actors with a ‘High’ level of adaptive capacity can be engaged in the proposed actions as 
they have the capacity to effectively respond to the impacts of the fragile systems. Similarly, those 
falling in the ‘Medium’ category might also need to be specifically targeted or can also be engaged 
in the proposed actions, depending on which end of the range they are on i.e. closer to the ‘low’ 
category or closer to the ‘high’ category.

Adaptive Capacity Score Level of Adaptive Capacity

1 – 8

9 – 17

18 – 27

Low

Medium

High
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VULNERABLE PLACES AND PEOPLE
Tool 3.1

Climate
Fragility 

Statements

Area/ward Adaptive 
Capacity 

Score
(A)*(B)*(C)

Actors Supporting 
Notes

Capacity to 
Organise & 

Respond
(A)

Resources
(B)

Access to 
Information

(C)

e.g.: 
Contamination 
of water 
supply due to 
flooding made 
worse by lack 
of alternative 
sources

Ward 5 Slum dwellers

Private Sector

Resident 
Welfare 
Association

Water authority

NGO

1 (Low)

12 (Medium)

4 (Low)

18 (High)

6 (Low)

Dependent on 
shallow aquifers 
that are easily 
contaminated; 
access to water 
tankers too 
expensive; no 
information on 
water purification 
techniques

1

2

2

2

2

1

3

2

3

1

1

2

1

3

3

Have you:

Mapped the most vulnerable areas in your city?

Developed a Vulnerability Hotspots map?

Identified the key actors for each Climate Risk?

Made sure to include all kind of vulnerable people?

Assessed the adaptive capacity of each group of actors?

Exercise 2: Actors Analysis
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ASSESSING THE
ADAPTIVE CAPACITIES 
OF URBAN SYSTEMS

ICLEI ACCCRN Process

Adaptive capacity is the capacity of the systems to absorb 
shocks and their response to these shocks. It therefore plays an 
important role in determining the resilience of these systems. In 
this tool, the adaptive capacity of the fragile urban systems of the 
city will be determined.

Some Background:
The Urban Climate Resilience Planning Framework describes the 
importance of adaptive capacity as:

the ability to shift strategies as conditions change in order to maintain the 
well-being of populations and the ecosystems on which they depend. In 
the context of climate change, adaptive capacity requires agents [actors] 
to make choices and respond to opportunities in ways that manage both 
direct and indirect climate impacts. Agents’ [actors] level of access to 
resilient systems influences their adaptive capacity, as does the manner 
in which institutions [rules and practices] structure relationships among 
agents [actors] and between agents [actors] and systems (pg. 156-157).

Adaptive capacity can be described on the basis of five broad 
categories – economic, technology/ infrastructure, governance, 
social, ecosystem services. 

TOOL 3.2
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ASSESSING THE ADAPTIVE CAPACITIES
OF URBAN SYSTEMS

Tool 3.2

EXERCISE 1 DETERMINING THE ADAPTIVE CAPACITY OF URBAN SYSTEMS

Step 1 
Complete Table 1 below.  Select only the identified fragile urban systems used for analysis in Tool 
2.2 (and not the climate risk statements), e.g. Water Supply . 

Step 2 	
For each fragile urban system describe its adaptive capacity in terms of five broad categories:
• economic, 
• technology/ infrastructure, 
• governance,
• social, 
• ecosystem services. 

Table 1 provides a description of each of the categories. 

Step 3:
For each fragile system rate each of the five categories of adaptive capacity as high/medium/low .

Take the fragile urban systems 
from Tool 2.2, Exercise 1

Describe the adaptive capacity 
of these fragile urban systems

Rate their adaptive capacity

Some Guiding Questions 

Economic – does the system have the financial resources to undertake the necessary 
actions to manage Climate Change – e.g. budget allocation, tax base, ability to charge fees? 
Is it able to operate as a “business” or does it follow the traditional public service model?

Technology/ Infrastructure – does the system have the necessary technological 
knowledge and resources? Is current infrastructure adequate to cope with additional 
stresses from Climate Change? Are major changes to technology needed? What is the 
capacity to introduce required changes?

Governance – is responsibility for this system clearly established?  Does the responsible 
entity have the necessary authority to make the required changes? Is there sufficient support 
from higher levels of government?  Are the stakeholders coordinated and supportive of 
necessary change?

Social – does the community have the understanding and resources necessary to play their 
part in this system? Does the system have in-built mechanisms to incorporate community 
and user input and feedback?  Does the system recognize the needs of poor and vulnerable 
groups in the community?

Ecosystems – what is the capacity of this system to protect or restore the ecosystem? Is 
there adequate understanding and data about the current status of the different ecosystems 
within the city, their strengths and weaknesses?

Your responses in the Baseline 
Questionnaire, Tool 1.3 may help 

with this assessment.  
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Example: Following is a reference table for compiling information about the adaptive capacity of the fragile urban systems.

Examples of Resources to Enhance Adaptive Capacity

Low

High

Economic GovernanceTechnology/
Infrastructure

Societal Ecosystem 
Services/Natural 

Environment

Limited inherent 
economic ability 
to adapt to 
impacts (e.g. no 
legal authority to 
raise funds; no 
strong tax base to 
call upon)

Robust inherent 
economic ability 
to adapt to 
impacts (e.g. 
mechanism for 
raising funds 
exist; very strong 
tax base to call 
upon)

Limited inherent 
technology/
infrastructure 
to adapt to 
impacts (e.g. 
use of outdated 
materials in 
structural codes; 
no system for 
integrating new 
knowledge into 
changes)

Robust inherent 
technology/
infrastructure to 
adapt to impacts 
(e.g. most 
structures are 
new and have 
used the latest 
materials & 
structural codes; 
new knowledge 
is regularly 
integrated into 
purchasing 
agreements)

Limited 
governance 
structure in 
place to adapt 
to impacts (e.g. 
no interagency 
collaboration; 
no support from 
higher levels) 
i.e. Rules and 
Practices

Robust 
governance 
structure in 
place to adapt 
to impacts (e.g. 
good interagency 
collaborative 
processes; work 
closely with 
higher levels) 
i.e. Rules and 
Practices

Limited societal 
structure in 
place to adapt 
to impacts (e.g. 
disenfranchised 
or uninvolved 
citizenry; lack of 
community & aid)

Robust societal 
structure in 
place to adapt 
to impacts 
(e.g. citizens 
are heavily 
involved in their 
communities; 
active and 
effective 
community & aid)

Limited 
ecosystem 
services/natural 
environmental 
ability to adapt 
to impacts (e.g. 
no marsh or 
dune system to 
provide storm 
protection; all 
habitat is isolated 
and disconnected 
from other 
natural areas)

Robust ecosystem 
services/natural 
environmental 
ability to adapt 
to impacts (e.g. 
highly functioning 
dune or marsh 
system provides 
storm protection; 
habitat systems 
are connected 
allowing for 
species and 
sediment 
movement)

Tool 3.2
ASSESSING THE ADAPTIVE CAPACITIES

OF URBAN SYSTEMS
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Table 1 Adaptive Capacity of the Fragile Urban System - Example and Exercise

Fragile urban 
system

Economic Technology/ 
Infrastructure

Governance Societal Ecosystem
Services

e.g. Water supply High (increasing 
demand from 
citizens for 
improved water 
supply systems)

Low (funds not 
available for new 
infrastructure)

Medium (access 
to improved 
technology can be 
accessed through 
engagement 
of private 
companies)

Medium 
(coordination 
with Irrigation 
and Public 
Health Dept to be 
improved) 

Low (water bodies 
being lost in the 
city)

ASSESSING THE ADAPTIVE CAPACITIES
OF URBAN SYSTEMS

Tool 3.2

Look back at the vulnerable 
actors and places (tool 3.1)

And now bring it all together in 
table 2
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Tool 3.2
ASSESSING THE ADAPTIVE CAPACITIES

OF URBAN SYSTEMS

EXERCISE 2 BRINGING IT ALL TOGETHER

This section summarises the assessment carried out in Tool 3.1 and Tool 3.2

Table 2 below provides a summary of the analysis from Phases 2 and 3 and can be used as a 
progress report for the city decision makers.

Step 1 	
Note the climate risk statements in your city which have been identified to have medium or high 
risk (refer back to Tool 2.3).

Step 2
Sum up the information documented in Tool 3.1 for these climate fragilities. This information 
includes identification of vulnerable areas and of urban actors . 

Step 3 
Next, sum up the adaptive capacity of the fragile urban systems using the results of Exercise 1 
above .
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Table 2 Bringing It All Together - Example and Exercise

Climate Fragility 
Statements

Vulnerable Areas

Vulnerable 
Actors

Potential 
Supporting 

Actor

Low Medium High

Urban Actors Adaptive Capacity of the System

e.g.: Contamination 
of water supply due 
to flooding made 
worse by lack of 
alternative sources

Ward 5 • Slum Dwellers

• Resident  
Welfare 
Association

• NGOs

• Private sector 

• Water Authority

Economic

Ecosystem 
Services

Technology

Governance

Societal

Have you:

Rated the adaptive capacity of the fragile urban systems?

Listed, for each Climate Risk Statement, the vulnerable areas, actors and the adaptive 
capacity of the urban system?

Finalized Table 2?  This will provide you with key information later on. 

References 
Moench, M., S. Tyler, et al. (2011), Catalyzing Urban Climate Resilience: applying resilience 
Concepts to Planning Practice in the ACCCRN Program (2009–2011), The Institute for Social and 
Environmental Transition, International, Boulder, CO, USA
http://www.i-s-e-t.org/images/pdfs/ISET_CatalyzingUrbanResilience_allchapters.pdf 

ASSESSING THE ADAPTIVE CAPACITIES
OF URBAN SYSTEMS

Tool 3.2
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DATA GAP
ANALYSIS  

ICLEI ACCCRN Process

Having understood the key fragilities of your city’s critical urban 
systems, this section highlights the various data gaps present 
in these systems. It therefore helps in identifying further data 
collection or research which may be required for a particular 
system. The scoping exercise, climate ready review, and urban 
system analysis together help in gathering data about these 
systems. This section draws from the information gathered under 
these tools.

TOOL 3.3

How to Assess the Adaptive Capacity of Urban Systems:
As mentioned in Tool 3.1, the exercises in this tool should 
be part of the same workshop organised by the Core Team. 
Having mapped the vulnerable areas of the city and identified 
the actors/stakeholders who may be most affected or who 
may be instrumental in the responses (Output of Tool 3.1), and 
having determined the adaptive capacity of the fragile urban 
systems (Output of Tool 3.2), we now identify data gaps of the 
fragile urban systems. 

The exercises mentioned in this tool can be undertaken jointly 
by the Core Team and the Stakeholder Group in the manner 
detailed out in the ‘How to’ section of Tool 3.1.
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DATA GAP ANALYSIS  
Tool 3.3

EXERCISE 1: DATA GAP ANALYSIS 
The exercise helps in identifying the gaps present in the availability of data for each fragile urban 
system. This will help in determining the need for detailed sectoral studies that need to be 
undertaken for each of these urban systems. 

Please follow the steps below to complete Exercise 1.

Step 1: 
Select the climate risk statements which have been mapped in Tool 3.1 . 

Step 2: 
For each of the climate risk statements, list data that has been gathered in the previous tools . 

Step 3: 
For each of the climate risk statements identify the main data gaps that have been observed.

Exercise 1: Data Gap Analysis  - Example and Exercise

Based on this exercise, and discussions within the Climate Core Team, please assess whether 
there is a need for sector-specific studies to be undertaken to develop an improved understanding 
of the climate vulnerabilities and corresponding resilience actions. 

Please list the sector studies to be undertaken, potential agencies (from within the Stakeholder 
Group if possible) that could undertake it, and where funding for this study could come from.

Look back at the climate risk 
statements of tool 3.1

For each one, list data available

Please Note: refer also to Tool 1.3: Exercise 5 - Availability of Data

Climate Risk Statement Data Available Data Gaps

e.g.: Contamination of 
water supply due to 
flooding made worse by 
lack of alternative sources

• Water supply in litres 
per capita per day for each 
ward

• .....

• Water supply to
un-notified slums

• Regular monitoring of 
water quality

• ......

Have you:

Listed the data available for each Climate Risk Statement? 

Identified the gaps in data?

What are the data gaps?
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ENGAGEMENT 
CHECKLIST 

ICLEI ACCCRN Process

As you work through the process you may discover issues and 
groups of stakeholders that were not identified initially.  There will 
be points where you need to consult external groups and points 
where you need to report back to the city decision makers. It is 
therefore essential that you revisit and review at key points the 
engagement decisions taken so far and ensure that the support 
structures for the climate planning are in place. This is also the 
moment to identify key messages to be shared without the larger 
group.

PHASE 3



Categories Questions Yes/No Comments

Climate core team

External stakeholders

Consultation

Communication

Reporting

Do you have the relevant 
department/sectoral 
representatives, do you 
need to invite additional 
people if you have identified 
unexpected climate impacts 
or actions? 

Do you have the key 
stakeholders to cover each 
climate issue or action 
identified? 

Have you reached a point 
where you need to consult 
widely, or consult particular 
groups?

Is there new information, 
or better understanding of 
climate issues, which should 
now be communicated?  If so, 
to whom, how and when? 

Is it time to report back to the 
Mayor, or council, or senior 
management (or another key 
stakeholder?)

(You might have 
to go back to Tool 
1.1 and update the 
information)

(You might have 
to go back to Tool 
1.2 and update the 
information)

(You might have 
to go back to Tool 
1.5 and update the 
information)

Notes

ICLEI ACCCRN PROCESS 93

ENGAGEMENT CHECKLIST  
Phase 3
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PHASE 4
ICLEI ACCCRN Process
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CITY RESILIENCE 
STRATEGY

Overview of Phase 4

ICLEI ACCCRN Process

In this Phase you will use the information and analysis from Phases 2 and 3 to develop a list of 
possible adaptation actions, or “interventions”.  You will then screen and prioritise the interventions, 
link them to existing city plans, and assemble all the information into a City Resilience Strategy. 

The tools included in Phase 4 and their corresponding objectives are:

Tool 4.1: Resilience Interventions - to develop a list of possible adaptation actions or 
“interventions” to address the climate risks and vulnerabilities identified in Phases 2 and 3 

Tool 4.2: Prioritisation of Resilience Interventions - to evaluate the proposed list of interventions 
against a set of resilience indicators 

Tool 4.3: Integration into City Plans - to determine whether the required interventions can be 
integrated with no or minimum additional resources into an existing departmental programme or 
project, rather than be a stand-alone initiative 

Tool 4.4: City Resilience Strategy – to support the development of a City Resilience Strategy 
(CRS). The CRS will collate all the information generated in the first four phases of the ICLEI 
ACCCRN Process and present a synthesized set of proposed actions 

TOOL 4.0
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RESILIENCE
INTERVENTIONS

ICLEI ACCCRN Process

This  tool will help you to develop a list of possible adaptation actions 
or “interventions” to address the climate risks and vulnerabilities 
identified in Phases 2 and 3. 

We will use the term “intervention”, but you will also see “actions” 
and “measures” at times in the text.  This is distinct from the term 
“strategy”, which will be used to mean the overall collection of 
interventions.

TOOL 4.1

How to Identify Climate Resilient Interventions:
The city Climate Core Team should conduct a 1 – 1.5 days 
workshop in which Tool 4.1, Tool 4.2 and Tool 4.3 can be 
implemented one following the other, since each is dependent 
on the previous Tool. The outputs of this workshop would be:

• Identification of potential climate resilient interventions 
for each of the high-risk climate fragilities targeting specific 
vulnerable urban actors and areas in the cities (Output of Tool 
4.1)
• A prioritised list of these interventions based on resilience 
indicators and feasibility criteria (Output of Tool 4.2)
• Linking prioritised interventions to ongoing or planned 
programmes (Output of Tool 4.3)

It is important to incorporate the views of the stakeholder 
group as well. There are two ways in which the Core Team 
could proceed:
 
1. The Core Team undertakes this exercise on their own and 
then shares the results with the Stakeholder Group for their 
feedback and support
2. The exercises in tools 4.1, 4.2 and 4.3 are undertaken jointly 
by the Core Team and the Stakeholder Group as part of a 
consultation process.

The 2nd option is recommended as it is more participatory and 
inclusive and allows for greater interactions and discussions 
between the Core Team and the Stakeholder Group. It allows 
for the same issue (e.g. identification of potential climate 
resilient interventions) to be discussed by different groups of 
heterogeneous participants and it provides an opportunity to 
every group to present their results and to debate and finalise 
together the outputs of the exercise. This approach can be 
repeated for other exercises as well as for generating greater 
discussions and consensus building on the outputs. 
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RESILIENCE INTERVENTIONS
Tool 4.1

EXERCISE 1:  DEVELOPING CLIMATE RESILIENCE INTERVENTIONS

Some Background:
Each locality or community experiences climate change in unique ways, depending upon 
topography, geographic location, features of the local ecosystem, along with social, urban and 
economic factors.  Therefore the adaptive responses of each community will be individual.  
However, collectively, many communities have already identified responses to particular climate 
exposures, and this can be useful information for a city which is starting out on the process.  

Resilience means the ability to withstand or accommodate stresses and shocks to a system while 
still maintaining the system’s function (ISET, 2011). It is the capacity and ability of a community to 
withstand stress, survive, adapt, bounce back from a crisis or disaster and rapidly move on. Urban 
resilience building is more than just successful climate change adaptation - water, energy, 
food security, greenhouse gas reductions, ecosystem protection, disaster risk reduction, 
must all be integrated into City Development Planning.  Urban resilience should integrate 
climate change strategies with all the other key sectors and priorities.  

Proposals for resilience actions or interventions can be developed in several ways :

APPROACH 1
In some cases an action or response is obvious, has already been identified or observed in 
another locality. Stakeholder Group and City Core Team members will typically already have a 
number of ideas quite early in the process – these are legitimate and should be listed.

APPROACH 2
Research into case studies and best practices from other areas can provide a rich source 
of possible interventions. ICLEI can provide a large number of case studies from all over the 
world (www.iclei.org); there are also several websites which will provide a useful starting point for 
research.  

APPROACH 3
The limitations with Approaches 1 and 2 is that you are not moving beyond the predictable, 
already known responses. Your city context is unique so it is important that you undertake an 
analysis which can uncover some of the underlying causes. One way of doing this is through an 
Intervention Mapping process, developed by ICLEI Oceania.

Please refer to Reference Tool 11 
Intervention Mapping PowerPoint 

Reference Tool 10
Menu of climate adaptation actions. 
This reference tool gives examples 

of lists of actions and projects 
developed in a range of climate 

resilience programs 
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RESILIENCE INTERVENTIONS
Tool 4.1

Step 1 
Build on Table 2: Bringing it all Together in Tool 3.2 (see Exercise in Table 1 on the next page). 
Start generating responses by one or more of the approaches listed above for each of the Climate 
Risk Statements.  

Step 2 
Consult stakeholders and sectoral agencies affected.  Ideally, the city Climate Core Team should 
conduct a 1 – 1.5 day workshop in which Tool 4.1 (as well as Tool 4.2 and Tool 4.3 since each is 
dependent on the previous tool) can be implemented.

Step 3    
Remember to:
• Focus on the most vulnerable groups (please make sure to include poor and marginalized 
ones), sectors, neighbourhoods
• Develop measures to address current issues and measures to prevent future problems
• Aim for a mix of “hard” (i.e. infrastructure related) and “soft” (i.e. non or minor infrastructure 
related e.g. policy changes, capacity building) solutions
• Consider links with other existing plans and processes to identify actions which may already be 
included in city plans

Step 4    
For each Climate Risk Statement, compile a list of possible interventions, specifically keeping 
in mind the vulnerable actors and how the intervention would benefit them and the adaptive 
capacity of the urban system under consideration.  You may want to refer to Reference Tool 10 at 
this point.  

Look back at table 2 of Tool 
3.2 and list responses for each 
Climate Risk Statement

Compile a list of possible 
interventions for each Climate 
Risk Statement

Refer to Reference 10,
“Intervention Mapping”, for help
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RESILIENCE INTERVENTIONS
Tool 4.1

Table 1: Identifying Resilience Interventions – Example and exercise

Climate
Fragility 

Statements

Vulnerable 
Areas

Potential Cli-
mate

Resilience 
InterventionsVulnerable 

Actors
Potential 

Supporting 
Actor

Low Medium High

Urban Actors Adaptive Capacity of the System

e.g.: 
Contamination 
of water 
supply due to 
flooding made 
worse by lack 
of alternative 
sources

Ward 5 • Slum 
Dwellers

• Resident  
Welfare 
Association

• NGOs

• Private 
sector 

• Water 
Authority

Economic

Ecosystem 
Services

Technology

Governance

Societal •Rooftop water 
harvesting and 
safe storage
•Capacity 
building on 
hygiene and 
sanitation
•Provision 
of low cost, 
effective water 
purifiers

Have you:

Drafted responses for each of the Climate Risk Statements previously identified?

Compiled a list of possible interventions for each one?

Involved or at least consulted the Stakeholder Group when carrying out this process?
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PRIORITISATION
OF RESILIENCE
INTERVENTIONS 

ICLEI ACCCRN Process

In this tool the proposed interventions are first assessed for their 
contributions to urban resilience using a set of resilience indicators.  
The higher scoring interventions are then assessed for feasibility 
and impact. 

TOOL 4.2

How to Prioritise Climate Resilient Interventions:
As mentioned in Tool 4.1, the exercises in this tool should be 
part of the same workshop organised by the Core Team. Having 
identified potential climate resilient interventions for each of 
the high-risk climate fragilities, we will now prioritise these 
interventions based on resilience indicators and feasibility 
criteria. 

The exercises mentioned in this tool can be undertaken jointly 
by the Core Team and the Stakeholder Group in the manner 
detailed out in the ‘How to’ section of Tool 4.1. 
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PRIORITISATION OF RESILIENCE INTERVENTIONS 
Tool 4.2

EXERCISE 1 PRIORITISING RESILIENCE INTERVENTIONS 
Earlier in the toolkit we used several criteria to assess the resilience of systems (Tool 2.2) and of 
actors (Tool 3.1 ).  In this Tool, these criteria have been combined for the following exercise, aimed 
at testing the resilience of interventions based on the characteristics mentioned below:

Redundancy: A resilient system can function and achieve results through multiple paths or 
nodes when one fails and when performance is critical.   In contrast, a “single best solution” 
is not resilient because if this single option fails, the system collapses. Back-up systems, or 
decentralised nodes for service delivery in a linked network, are preferable. 
Example: Hospitals and emergency communications facilities have shared or linked backup electrical 
generators 

Flexibility and diversity: Essential systems should be able to work under a variety of 
conditions; they should not be rigid or designed only for one specific situation.  Any system will 
fail if overloaded beyond its capacity, but it should be designed to fail under stress in a safe and 
predictable way, rather than suddenly and catastrophically. 
Example: Dikes are designed so that if their capacity is exceeded, they fail in predictable ways, channelling 
flooding away from populated areas 

Re-organisation and responsiveness: Under extreme conditions, systems should be able to 
respond and change to meet unexpected shocks. This requires flexible organisations and access 
to different kinds of resources (information, skills, equipment, knowledge and experience). It also 
means a high level of coordination and flexible organisational structures capable of adjusting to 
new conditions. 
Example: Houses in flood-prone areas are designed with flat roofs as emergency refuges for family 
members and possessions above flood water level 

Access to information: Resilient systems have mechanisms to learn from and build on 
experience, so that past mistakes are not repeated and lessons from other cities can be integrated 
into planning. This requires procedures for monitoring and evaluating performance under stress, 
and requires multiple sources of knowledge and documentation (strengthening “corporate 
memory”). 
Example: Different government agencies share a common monitoring and reporting system to track 
groundwater quality and extraction in the face of more frequent drought or sea level rise
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PRIORITISATION OF RESILIENCE INTERVENTIONS
Tool 4.2

Step 1 	
List the resilience interventions from Tool 4.1 .

Step 2
Evaluate them on the basis of the above resilience indicators. 

Step 3  
Complete Table 1 by determining the overall resilience score for each intervention on the basis of 
the number of resilience indicators that the intervention is perceived to fulfil. 

For example, if an intervention meets the criteria of redundancy, and enhances the urban system’s 
capacity to learn but does not help the system in being responsive and is not flexible or robust - thereby 
meeting 2 out of the 4 characteristics of resilience – then the overall resilience of the intervention will be 
2/4 – ‘Average’ (see Table 1 below). 

Table 1: Prioritising resilience interventions – Example and exercise

Assign a resilience score to 
each intervention (from Tool 
4.1) based on the resilience 
indicators above.

Potential Climate 
Resilience

Interventions

Resilience Indicators

Flexibility
(yes/no)

Access to
Information

(yes/no)

Redundancy
(yes/no)

Responsiveness/ 
re-organisation

(yes/no)

Overall
Resilience 
4/4: High

3/4: Medium
2/4: Average

 1/4: Low

e.g. Roof top water 
harvesting to be 
made mandatory 
to deal with 
water stress due 
to anticipated 
increasing 
temperatures 
and decreasing 
precipitation 

Yes

System allows 
for water to be 
channelized 
towards recharging 
groundwater as 
well 

No

City helplines exist, 
but responsibility 
lies with individual 
households

Yes

Supports a higher 
degree of self 
sufficiency at the 
household level

Yes

In case of shutdown 
of the city’s water 
supply system, 
households have 
stored rainwater 
for use 

Medium
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EXERCISE 2 FEASIBILITY AND IMPACT
As well as building resilience, interventions should be checked for their feasibility and expected 
impact.  

Feasibility can be assessed using the following criteria:
• Technical – the city has the necessary technical expertise to implement the project, or can 
access the required skills
• Political – the intervention will be seen as acceptable to city leaders and the community and is 
consistent with the city’s values and vision
• Cost-benefit – the cost is within the capacity of the city, or the city will be able to access 
required funds, and the anticipated benefits of the action will justify the cost
• Responsibility - An assessment of whether this action falls within the role of the city 
government, or which other agencies may need to be involved (Please refer back to your 
responses on ‘part of city function’ in Table 1 of Tool 2.2) 

Impact can be assessed using:
• Timeframe – most actions should be able to be completed within a short or medium 
timeframe.
• Overall impact  - the proposed intervention will have a significant and measurable impact on 
the targeted climate risk

Step 1 	
Using Table 2, list the resilience interventions that have been assessed to have either a High or 
Medium score in Exercise 1.

Step 2 
Now, evaluate the interventions in terms of their feasibility and impact. 

Table 2 Feasibility and Impact – Example

Potential Climate 
Resilience

Interventions

Feasibility Impact

Politically
(high/medium /low)

Technically
(high/medium/low)

Cost
(high/medium /low)

(short/medium/long 
term)

e.g. Roof top water 
harvesting to be 
made mandatory 
to deal with 
water stress due 
to anticipated 
increasing 
temperatures 
and decreasing 
precipitation

Medium 
(would require a 
change in building 
by- laws and building 
codes)
 

High (technology is 
easily available) 

High
(not an expensive 
option to implement 
with substantial 
results)
 

Short term

Evaluate the feasibility 
and impact of the ‘high’ 

and ‘medium’ resilience 
interventions
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Have you:

Assigned a resilience score to each intervention?

Evaluated the feasibility and impact of the ‘high’ and ‘medium’ ones?

Developed a final list of recommended interventions?

Involved or at least consulted the Stakeholder Group in this analysis?

PRIORITISATION OF RESILIENCE INTERVENTIONS
Tool 4.2

Step 3 
Use these ratings to develop a final list of recommended interventions.  The method for arriving 
at a recommended list may vary according to your city’s way of making decisions.  Some options:

1. Apply scores to the Feasibility and Impact ratings and use total scores to prioritise.  Keep in 
mind that this might be over-simplistic as there may be very good reason to choose an interven-
tion which does not score as highly as some others.

2. Conduct discussions with the Climate Core Team and/or the Stakeholder Group to validate the 
ratings and search for any other reasons which may help with the shortlisting

3. Provide a longer list to city decision makers and allow the city’s normal budget prioritisation 
system to make a final selection.

Develop a final list of 
recommended interventions



PRIORITISATION OF RESILIENCE INTERVENTIONS
Tool 4.2

Notes
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INTEGRATION INTO 
CITY PLANS 

ICLEI ACCCRN Process

In  the previous tool, a shortlist of recommended interventions has 
been developed using Feasibility and Impact criteria. Tool 4.3 will 
now assist you to align the proposed actions with existing city plans. 

A city government will already have a comprehensive set of plans, 
ongoing programs and projects. Wherever possible, climate 
resilience interventions should be linked with, or built into, 
existing departmental workplans. It is far better for the City to 
integrate the City Resilience Strategy (CRS) into existing plans 
than to adopt another new plan. The CRS should be seen as a way of 
strengthening the resilience of city plans, rather than an additional 
workload.

TOOL 4.3

How to Integrate Climate Resilient Interventions into City 
Plans:
As mentioned in Tool 4.1, the exercises in this tool should 
be part of the same workshop organised by the Core Team. 
Having identified potential climate resilient interventions 
for each of the high-risk climate fragilities, and having 
prioritised these interventions based on resilience indicators 
and feasibility criteria, we would now aim to identify ongoing 
or upcoming programs and projects to streamline these 
resilience interventions. 

The exercises mentioned in this tool can be undertaken jointly 
by the Core Team and the Stakeholder Group in the manner 
detailed out in the ‘How to’ section of Tool 4.1. 



INTEGRATION INTO CITY PLANS
Tool 4.3

EXERCISE 1: LINKING RESILIENCE INTERVENTIONS TO ONGOING PROGRAMS
Step 1 	
Begin with the list of recommended interventions from Tool 4.2 .  

Step 2  
For each of the resilience interventions identify the relevant plans and programs of the city 
government into which the intervention can possibly be incorporated.

Step 3  
Now, check the timeframe of the existing program to ensure it is consistent with the proposed 
intervention.

Step 4
Finally, determine if the programme can be leveraged to include the intervention:
• Can the intervention be included without requiring additional resources?
• Can the intervention be included with minimal extra resources, as compared to undertaking the 
intervention as a stand-alone initiative?

Table 1 Linking Resilience Interventions to Ongoing Programs – Example and Exercise

Resilience
Interventions

Relevant
Programs

Ongoing/upcoming/ 
planned

Can the program be leveraged – 
yes/no; if yes how?

e.g. Roof top water 
harvesting to be made 
mandatory to deal with 
water stress due to 
anticipated increasing 
temperatures 
and decreasing 
precipitation

Housing Scheme for 
the Urban Poor

Upcoming (following 
financial year)

Yes. Design of buildings can be modified to include 
a rooftop water harvesting and safe storage system

Look back at the recommended 
interventions from Tool 4.2

Are there existing plans in 
which these interventions can 

be incorporated?

Do the timeframes match?

Can this be done with no or 
minimal extra resources?
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Bring together interventions, 
vulnerable areas and actors, 
and related city plans

EXERCISE 2 SUMMARISING RECOMMENDED RESILIENCE INTERVENTIONS
The following table is a way of summarising the recommended interventions, the target areas 
and actors (both of these are listed in Exercise 1 of Tool  4.1), and opportunities to link and lever-
age interventions to existing city plans.  This is just one example of a summary document.  In this 
case, the interventions which cannot be easily linked to existing city plans are listed separately.  
These may need separate budget decisions, or funding from alternative sources.

You may need to design your own summaries according to local reporting and decision-making 
requirements.  

Table 2 Summary of recommended interventions and related city plans – Exercise and Example

Recommended Resilience 
Interventions

Target
Actors

Vulnerable
Areas

Not Related to
Existing City Plans 

Recommended Resilience 
Interventions

Target
Actors

Vulnerable
Areas

Related
City Plans 

e.g. Roof top water harvesting 
to be made mandatory to 
deal with water stress due 
to anticipated increasing 
temperatures and decreasing 
precipitation

• Slum Dwellers
• Resident Welfare Association
• NGOs

Ward 5 Housing Scheme for the 
Urban Poor
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Have you:

Analysed existing plans in which the recommended interventions can be incorporated?

Checked if the timeframes match?

Ensured that no or minimal additional resources are needed?

Involved or at least consulted the Stakeholder Group in this exercise?

Notes
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CITY RESILIENCE 
STRATEGY 

ICLEI ACCCRN Process

The City Resilience Strategy (CRS) collates all the information 
generated in the first four phases of the ICLEI ACCCRN Process, 
and presents a synthesised set of proposed actions. It is both a 
strategic statement and also the basis for an implementation plan.
   
The document should be written in a format consistent with your 
city’s planning documents. The primary audience for the CRS will 
be the city’s decision makers. However sections may also be written 
for broader audiences, or a summary version may be produced for 
wider use. 

TOOL 4.4

This tool provides some recommended headings and content 
for a CRS, but the actual format may vary according to local 
requirements.



CITY RESILIENCE STRATEGY
Tool 4.4

EXAMPLE OF CITY RESILIENCE STRATEGY OUTLINE

INTRODUCTION
This section in the City Resilience Strategy introduces the concept of urban climate change 
resilience for the city, the rationale of conducting an assessment of vulnerability to climate change 
for the city and the methodology used for this assessment.

1. Brief outline of urban climate change resilience
	 a What is climate change 
	 b. What is climate resilience

2. Benefits of climate change resilience building  for cities
	 a. What are the possible benefits of climate resilience for urban local bodies

3. Please explore economic, environmental and social benefits of resilience actions 

4. Methodology of assessment 
	 a Explanation of the different steps of the ICLEI ACCCRN Process
	 b. Possible annexes
		  i. List of members of climate core team
		  ii. List of members of stakeholder group
		  iii. Public communications from the climate core team (for instance, minutes of 	
		  meeting, newspaper cuttings, memos, etc)

CITY PROFILE
This  section of the City Resilience Strategy provides detailed information regarding the city. The 
section should include basic information on: 

1. Location of the city
	 a. Reference with respect to latitude/longitude
	 b. Regional location of the city and geography
	 c. Information on area, number of wards, etc

2. Socio-economic profile of the city
	 a. Information on population, number of households, number of slums, marginalised 	
	 groups, urban poor
	 b. Information on economic profile of the population in the city

3. Demography of the city
	 a. Population data – general v/s urban poor
	 b. Population projections

4. Climate pattern of the city
	 a. General climatic pattern of the city
	 b. Seasonal information on temperature, precipitation

PAST HAZARDS AND CLIMATE EVENTS IN THE CITY
This  section gives detailed information of major climatic events faced by the city in the past years. 
Each extreme event faced by the city in the recent past is outlined with information on: 
1. Date of occurrence of event

2. Details of the event (for instance, reasons of occurrence of the event, details of the event) 

3. Impacts of the event on life and livelihood of the citizens, urban systems, and environment

4. Measures undertaken by the city or regional government to mitigate impacts of the event

5. Actions or measures undertaken by the city or regional government to address such 
occurrences in future, if any

Introduce the concept of urban 
climate change resilience and 
explain the methodology used

Provide city-specific information

Describe past major climatic 
events

ICLEI ACCCRN PROCESS 111



ICLEI ACCCRN PROCESS112

CITY RESILIENCE STRATEGY
Tool 4.4

CLIMATE SCENARIO IN THE CITY
This  section of the City Resilience Strategy analyses the past and future climatic trends of the city. 
Since city level climatic data trend analysis may not already be available, a preliminary analysis is 
conducted on the basis of climate data collected from official climate records. (Refer back to tool 
2.1)

1. Past Climatic Trends
A basic trend analysis is done for the past climate data collected for temperature and rainfall in 
the city collected from official records. Graphical representation of this analysis is presented in 
this section. 

2. Future Climatic Projections
In order to plan for increasing the climate resilience of a city it is crucial to know how the climate of 
that city would be in future. Therefore it is important to have the projected climate data. However, 
since local or city level projections of climatic trends are rarely available, regional level climatic 
projections can be used for this purpose. The projected climatic trends are outlined in this sub-
section.

VULNERABILITY ASSESSMENT
In  this section of the City Resilience Strategy, the vulnerability of the major urban systems in the 
city and the principal actors in the city is assessed. 

1. Urban Systems Analysis
The major and critical urban systems in the city are identified, and the impacts of climate change 
identified in the previous section on these systems are analysed.  This section determines the 
status of the urban systems and their fragility in terms of their flexibility, redundancy, and capacity 
of safe failure. The Urban Systems Tool 2.2 provides information for this section.
	 a. Information on each fragile urban system and the reasons for its fragility
	 b. Explanation on the impacts of climate change identified on these fragile urban systems

2. Risk Assessment
This section will prioritise the fragile urban systems in terms of the risk posed by the system to the 
city. The Urban Systems Tool 2.3 provides information for this section.
	 a. Information on scoring mechanism used for risk assessment
	 b. Table of fragile urban systems with calculated risks

3. Vulnerability Assessment
This section identifies the vulnerable areas, relevant actors and the adaptive capacity for each 
fragile urban system. The vulnerability assessment tool provides information which can be used in 
this section. For each fragile urban system, information is provided on
	 a. Vulnerable areas  identified for the fragile urban system, including map of the city 	
	 showing vulnerable area
	 b. Actors involved, for both supporting and managing the urban system and those who 	
	 are vulnerable to the impacts of these systems. 
	 c. Adaptive capacity of the fragile urban system 

5. Vulnerability Hotspots
The maps of the city, showing areas vulnerable to the different fragile urban systems are 
overlapped to create a vulnerability hotspot map, which shows the areas vulnerable to multiple 
fragile systems. This helps to focus resilience interventions in these areas while planning the 
resilience strategy

Analyse past and future climatic 
trends

Provide information on the 
vulnerable systems, areas and 
actors in your city
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RESILIENCE INTERVENTIONS
This section provides a list of all the resilience interventions identified to minimise and adapt to 
climate impacts for the identified fragile urban systems. Strategy should consist of: 

1. List of interventions and their applicability to the city evaluated in terms of their resilience 
(redundancy, flexibility/robustness, responsiveness/re-organisation, capacity to learn), feasibility 
(technical, political, cost), and benefits of the action (short term/medium term/long term).

2. Institutional responsibility – identification of responsible local/regional/national  authority or 
private organisation who would be responsible for carrying out the intervention in the city  

3. Timeframe – identification of possible and realistic timelines to carry out the identified 
interventions

4. Costs – identification of possible sources of funds for carrying out the interventions. 

5. Institutional mechanism in the city – details of political and administrative institutional 
mechanism that can be set up in the city for implementation of the resilience strategy thus 
developed.

WHAT IS A “GOOD” CITY RESILIENCE STRATEGY?
The prime purpose of your CRS is to assist with your own city’s planning.  However, international 
climate funding opportunities are now being developed for cities through a number of initiatives.  

One initiative is the Urban Climate Change Resilience Trust Fund (UCCRT), which was launched in 
November 2013.  This is jointly funded by the British Government’s Department for International 
Development and the Rockefeller Foundation, and will be managed by the Asian Development 
Bank. The Trust Fund will be used to fund planning, projects and knowledge sharing to help 25 
second tier cities in Bangladesh, India, Indonesia, Pakistan, Philippines and Vietnam mitigate 
the risks of increasing urbanisation and climate change on their population, particularly the 
urban poor. To qualify for this fund, cities will first have to demonstrate that they have followed a 
systematic process to assess their climate risks and generate project proposals .  

The CRS will provide the necessary documentation to demonstrate the planning process followed 
by the city.  

To ensure that your CRS is judged of good quality, it should: 
• have a minimum of 3 components :
	 • Climate impacts and vulnerabilities
	 • Proposed resilience actions
	 • Priorities
• be based on a systematic and comprehensive survey of climate impacts
• include a balance of hard and soft, long term and shorter term interventions
• promote future sustainability and resilience and fulfil the “Do No Harm” principle 
• include mechanisms for integration with other city plans
• include a system for Monitoring and Reporting
   (the subject of Phase 6 of the ICLEI ACCCRN Process)
 

List the resilience interventions 
planned

To see examples of
City Resilience Strategies

developed by ACCCRN cities,
write to iclei-southasia@iclei.org

Have you:

Developed your City Resilience Strategy?

Made sure it includes all relevant information?
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ENGAGEMENT 
CHECKLIST 

ICLEI ACCCRN Process

As you work through the process you may discover issues and 
groups of stakeholders that were not identified initially.  There will 
be points where you need to consult external groups and points 
where you need to report back to the city decision makers. It is 
therefore essential that you revisit and review at key points the 
engagement decisions taken so far and ensure that the support 
structures for the climate planning are in place. This is also the 
moment to identify key messages to be shared without the larger 
group.

PHASE 4



Categories Questions Yes/No Comments

Climate core team

External stakeholders

Consultation

Communication

Reporting

Do you have the relevant 
department/sectoral 
representatives, do you 
need to invite additional 
people if you have identified 
unexpected climate impacts 
or actions? 

Do you have the key 
stakeholders to cover each 
climate issue or action 
identified? 

Have you reached a point 
where you need to consult 
widely, or consult particular 
groups?

Is there new information, 
or better understanding of 
climate issues, which should 
now be communicated?  If so, 
to whom, how and when? 

Is it time to report back to the 
Mayor, or council, or senior 
management (or another key 
stakeholder?)

(You might have 
to go back to Tool 
1.1 and update the 
information)

(You might have 
to go back to Tool 
1.2 and update the 
information)

(You might have 
to go back to Tool 
1.5 and update the 
information)

Notes
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Notes
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Weather: Day-to-day temperature, humidity, precipitation activity, wind, atmospheric pressure.
Climate: Statistical distribution of weather patterns over long periods of time.
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SHARED LEARNING DIALOGUE

1. PURPOSE OF THIS TOOL
This tool provides a recommended methodology for conducting stakeholder engagement.  The Shared 
Learning Dialogue method was trialled in the ten original ACCCRN cities and is documented in the 
ISET publication “Catalyzing Urban Climate Resilience”. 
 
2. ABOUT THE TOOL

Introduction
A Shared Learning Dialogue (SLD) is a method of engagement with the relevant Stakeholders that your 
city government has identified in Phase 1 “Stakeholder Engagement”. 
The objectives of the Shared Learning Dialogue are:
1. To introduce the ICLEI ACCCRN initiative to the Stakeholder Group and a larger audience
2. To present the results of progress so far under the project
3. To solicit, discuss, and define the supporting role of the stakeholders in the ICLEI ACCCRN process
4. To potentially identify some key stakeholders from the group whose active participation could assist 
the implementation of the ICLEI ACCCRN process

Draft Terms of Reference 
Developing Terms of Reference for the stakeholder consultations will help streamline the process 
and develop greater clarity on why, for what, how and when such consultations should be organized. 
Provided below are indicative headings with supporting questions and examples that you could use to 
develop a Terms of Reference for the Stakeholder Consultations that your City will organize. 

Rationale
What is the reason for conducting these dialogues and using the SLD approach?  

Example (from ISET)
Stakeholder concerns and feedback are a valuable source of information that can improve 
the design and outcome of your City’s Climate Resilience Strategy, and can help your Core 
Team to identify adaptation actions. For stakeholders, consultations are an opportunity to: 
	
• Learn about the City’s Climate Resilience Strategy process
• Discover potential connections to their own programs, planning and funding mechanisms
• Raise issues and concerns, potentially helping to shape the strategy by making 
suggestions to the Climate Core Team

What is special about Shared Learning Dialogues?
• Information sharing is multi-dimensional.  Everyone contributes information and 
experience, everyone learns from the exchanges.  This helps to break down traditional 
boundaries between government, academic and community actors
• The process is conducted in an open manner and allows time for participants to absorb 
and use climate information
• The process is iterative, with several opportunities for members to meet and take their 
thinking to the next level
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Facilitation / Chairing of Stakeholder Consultations
Experience has shown that SLDs need to be highly structured and are best conducted by skilled, inde-
pendent facilitators.  However it may also be desirable to have a formal Chairperson, whose responsibility 
will be to report back to the City.

Roles & Functions
The roles may vary as the process progresses – from information sharing to problem solving and strategy 
designing. Define the roles and functions of the stakeholder consultation.

Recording, Reporting & Communications
It is important to be clear about the status of SLD outcomes, how these are fed into the city planning 
process.  It should also be determined who is able to make public statements about the SLD proceedings 
and outcomes.

Timing & Logistics of Meetings
Timing of meetings should be based on the process guide or adopted project plan.  If possible, determine 
in advance at what points in the process SLD meetings will be required.  Also determine time of day, 
location and maximum length of meetings.

Finally, careful planning for the Stakeholder Consultation is important. The example below 
provides an indicative checklist that could be used to ensure that all necessary preparations have 
been made. 

Key Steps & Proposed Structure for SLDs
Possible agenda
The workshop agenda may include:
1. Aims and objectives of the ICLEI ACCCRN Process, and how the city and its citizens will benefit 
2. The purpose of the SLD and the expected outcomes; proposed role of stakeholders in the 
process
3. Progress so far
4. Ongoing initiatives by various stakeholders that could support the ICLEI ACCCRN Process
5. Local knowledge and experience related to climate impacts and response / adaptation actions
6. Any other points that the stakeholders may want to discuss
7. Next steps for the Climate Core Team and Stakeholder Group

Example (from ISET)

Preparation Checklist:
• List of participants, based on Section A, and invitations
• Determine the day and date
• Prepare agenda and time tables
• Will a government institution be the host? Determine the venue
• Form and lay out tables – Round tables are recommended to facilitate discussion
• Responsibilities: Determine who is responsible for what activities
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If possible, an independent facilitator should be engaged to conduct the workshops.  The 
workshop may comprise of:

1. Open forum discussion: the suggested topics for discussions are displayed for all participants 
and they are invited to respond to them. In this approach the role of the Facilitator is very critical

2. Group Discussions: the participants are divided into groups comprising of 4-6 members per 
group, depending on the number of participants. Each group is then given 30 – 40 minutes 
to discuss amongst themselves the discussion points that have been provided to them (along 
the lines suggested above). One member of each group will be nominated to keep notes of 
the discussions in his/her group and then report back to all the participants. Once the group 
discussions are complete, each group representative would be given 5 – 8 minutes to present the 
points raised in their respective group to the larger group. Some time should also be provided to 
the other participants to question the group that is presenting.

Follow Up
It is recommended that within a period of 8 – 10 days after the workshop is organized, the 
proceedings of be circulated to all participants - for the records of both the city government and 
the stakeholders. 
The proceedings could include:

1. The main discussion points during the workshop: for this, you should consider appointing at 
least 2 people to keep notes of the discussions

2. The list of participants: the Names, Designations, Organizations, and Contact Details of all 
participants (that should be recorded at the start of the workshop) 

3. REFERENCES, LINKS
“Catalyzing Urban Climate Resilience”, ed Moench M, Tyler S, Lage J, 2011, ISET, Chapter 4 
www.i-s-e-t.org
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MAPPING TOOL SUPPORT

Introduction
Mapping of Vulnerable areas can be executed using free software alone or using multiple 
software in combination. This part of the toolkit contains detailed methods for mapping 
vulnerable areas within a city or any study region using open source software. The list of 
software/tools required is given below with download links:

a) Google Earth – Download Here: http://www.google.com/earth/download/ge/agree.html
b) DNR Garmin – Download Here: http://files.dnr.state.mn.us/aboutdnr/bureaus/mis/gis/tools/
arcview/extensions/dnrgarmin/dnrgarmin54setup.zip
c) SAGA GIS – Download Here: http://sourceforge.net/projects/saga-gis/files/latest/
download?source=files

Other tools required to execute this process are:	
a) Ward Map / Base Map 
b) Microsoft Excel

Using the above mentioned tools/Software, mapping of vulnerable areas can be done in two ways 
viz.

Method A: Using Google Earth, DNR Garmin & SAGA GIS in combination.

I) Creating polygons over an imported image in Google Earth and saving them in *.kml 
format.
Ward map image when imported in Google Earth will serve as a base for tracing outlines 
(boundaries) of respective wards. Each of these wards when traced will form a polygon (shape) 
which can be later used to represent a score with some colour coding.

II) Converting the Polygon (*.kml) files to ESRI shape file using DNR Garmin.
Polygons made in Google Earth are saved in *.kml format. This format is not supported by SAGA 
GIS and thus these files cannot be imported directly. Converting the file format to *.shp (ESRI 
Shapefile format) makes the import possible. 

III) Importing ESRI Shapefiles in SAGA GIS and attaching attributes/Scores/data to be 
represented on the map.
Importing shapefiles to SAGA GIS will facilitate in attaching scores to respective wards/polygons. 
These scores can be assigned some colour coding so that each colour or colour shade depicts a 
score/value.



ICLEI ACCCRN PROCESS134

REFERENCE TOOL 3

Method B: Using SAGA GIS Only.

I)   Importing Ward/Base Map in SAGA GIS
Ward map image when imported in SAGA GIS will serve as a base for tracing outlines 
(boundaries) of respective wards. 

II)  Making polygons/Shapefiles (Digitizing)
Polygons can be made by tracing respective ward boundaries from the ward map image. These 
polygons can be later associated with some score/value which can be represented using some 
colour coding. 

III) Adding attributes/Scores/Data to the Shapefiles and Exporting the Map.
Attribute table can be defined as the table containing information about a particular shape/
polygon. In this case, the attributes will be scores for different systems within a ward. Attaching 
attribute table will associate each polygon (Ward) with some scores/Values. These scores can be 
assigned some colour coding so that each colour or colour shade depicts a score/value.

Basic flow of both these methods is as follow:

Make Polygons

Assign scores to each 
Polygon

Represent the scores
using Colour Coding
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METHOD A: USING GOOGLE EARTH, DNR GARMIN & SAGA GIS IN COMBINATION

I) Creating polygons over imported image in Google Earth and Saving them in *.kml format
Step 1: Download and install the required software. It is worth noting that Google Earth, DNR 
Garmin & SAGA GIS are free software and can be downloaded from the links provided above.

Step 2: Start Google Earth and Locate your study region/city using the search box given in the top 
leftmost corner of your screen. The city of Barisal in Bangladesh is taken as an example in this 
case.

Step 3: Import an Image file of Ward/Base Map. This can be done by using the “Add > Image 
Overlay” function or by simply using the shortcut “Ctrl + shift + O”.

After clicking on “Image Overlay”, a window will pop-up. This window will help you browse your 
Map Image.
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After browsing the image, it will appear on the Google Earth interface. Before clicking “OK”, 
adjust the image size and position so that it perfectly overlays on the Study region/City. This can 
be done by increasing the transparency of the image and matching it with some identical features 
like rivers and land edges (if any). Image size can be adjusted using four corner brackets 
(Green) surrounding the image. Image position can be adjusted using the Cross/intersection/
plus sign in the centre. Diamond shaped box on the left edge of the image can be used to rotate 
it. Once the image is adjusted, Click “OK” to add image.

In this example, the image was resized and overlaid using a river and land edges as reference. 
Transparency was kept less than 50%. Refer to the figure below to see the overlay. After 
overlaying, the image transparency can be reduced from image properties in “My Places.”

Note: Appropriate/Perfect overlaying of the image is necessary only when the actual position of study 
region on Earth is to be displayed. This is termed as “Geo-referencing”. Geo-referencing once done can 
be useful for performing Digital Elevation Model (DEM) Analysis and for adding other geographic features, 
if required. 

However, if attaining an overlay is difficult or cumbersome, skip this step. Keep the image 
wherever it appears at first (after browsing) and Click OK and proceed to the next step.
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Step 4: Next, we need to draw (trace) the polygons (i.e City/Municipal Boundary or Ward 
Boundaries) using a very simple tool embedded in Google Earth. Start with clicking the “Add 
Polygon” Tool on the Google Earth Tool Menu (Refer the figure below).

After clicking the “Add Polygon” tool, a new window will pop-out and will prompt for the name of 
the Polygon. Give a name (Eg: Municipal Boundary, Ward 1, Ward 2, etc.) and before clicking OK 
extract/trace the polygon point to point. For a better accuracy, zoom in the map to get detailed 
shape of the desired polygon. Click the “Style, Color” Tab of the same window and select the 
line and fill colour of the polygon. Refer to the figure below.
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Click “OK” to finish extraction. Follow the same procedure for other polygons/boundaries/wards. 
It should be noted that the polygons/shapes will be on the left hand-side panel of Google Earth 
under “Places >My Places”. This place should be saved on the computer by “Right-clicking 
the place and simply selecting ‘Save as’”. Please note that the files should be saved in *.kml 
format (Refer the figure below).

Before closing Google Earth save all your places/Polygons. This can be done by selecting “File 
> Save > Save My Places.” This will help you in accessing the extracted polygons in Google 
Earth later.
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II)  Converting the Polygon (*.kml) files to ESRI shape file using DNR Garmin.
Step 1: In this step we’ll use DNR Garmin 5.4.1 to convert the previously saved *.kml (Google 
Earth) files to *.shp files (Shapefiles) so that these files can be further opened in SAGA GIS for 
spatial representation. Run DNR Garmin first. Sometimes, one or more error messages may 
appear regarding ‘Port’, simply ignore them (by Clicking OK).

To import the *.kml files in DNR Garmin, click “File > Load From > File”. A window will pop-
up with the help of which the file can be browsed. While selecting the file make sure that the file 
type is set to *.kml (Google Earth Format). When you locate your desired polygon file, the tool 
will prompt for the required ‘Output Shape’ in a new window (Ex: Point, Line or Polygon). Since 
we’ll be dealing with Municipal and ward boundaries, Polygon should be selected as our desired 
output shape.

Step 2: After selecting the output shape, a new window will appear showing all the points 
forming the polygon and their respective latitudes and longitudes. In most of the cases, the first 
point may not have the Latitudes and Longitudes. In order to avoid error it’s advisory to select the 
first row and delete it. Refer to the figures below.
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Step 3: After deleting the first row, set the projections (Co-ordinate system to represent 
Latitude & Longitude). This can be executed by Selecting “File > Set Projections” which will 
open a small window. Once the window appears, Select “None (in red) > OK”. This will set the 
projections to WGS 1984 (by default). Not performing this might cause error in converting 
shapefiles.

Step 4: After Setting the projections, go to “File > Save To > File”. This will prompt for a file 
name and file format. Select ‘ArcView Shapefile (Projected) (*.shp)’ as the file format and 
assign a name. If prompted again, select the output shape as polygon. Refer to the figure below.

Repeat the same procedure for other Boundaries like Wards, Water Bodies,etc. Save all *.shp files in 
one folder.
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III) Importing ESRI Shapefiles in SAGA GIS and attaching attributes/data to be represented 
on the map.
In this step we will import all the *.shp files in SAGA GIS, merge the necessary ones and add 
data/scores/attributes to these files so as to represent the data spatially. Following steps will 
guide you through.

Step 1: After downloading SAGA GIS, open the folder where it has been downloaded and double 
click on “saga_gui” (with blue icon). This software requires no installation.

SAGA GIS once started, will display three panels (Left, Middle and Right). The top of the left 
panel consists of three tabs viz. Modules, Data and Maps. Selecting “Data” will display all the 
polygons/shapes that you might import later. Refer to the figure below.

Step 2: The next step here is to import shapefiles in SAGA GIS. This can be executed by selecting 
“File > Shapes > Load” from the toolbar. Browse the folder where previously converted 
shapefiles were saved. Select all (Ctrl + A) of them and Click OPEN. Importing all files may take 
2-3 minutes depending on the number of files.
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Step 3: The next step here is to merge all the shapefiles into one Layer. Merging will help us in 
assigning scores/attributes to all the shapes/polygons (Wards) in one go. Merging can be done 
by selecting “Modules > Shapes > Construction > Merge Shapefiles”. A window will pop-up 
and will prompt for three field viz. Merged Layer, Main Layer and Additional Layers. Keep 
settings as shown in the figure below. The City/Municipal Boundary should be set as the “Main 
Layer”. All Ward shapefiles should be added as “Additional Layers”. This can be executed by 
using the tab shown in the figure (Red Arrow). Click the tab and add all ward shapefiles. It should 
be noted that the City Boundary Polygon should not be included in the selection since it has been 
already set as the “Main Layer”.

Following screen will appear on clicking the add tab. Select only the ward shapefiles and click 
“Okay”. The previous window will appear again. Click “Okay” and let the merging execute. This 
will create a new shape layer in the “Data Frame” with the name “Shapes_Merge”. 
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Step 4: Now that we have all shapefiles merged into one layer i.e “shapes_merge”, except for 
this “Shapes_merge” layer, Close / remove all the previously imported layers,. This removal/
deletion can be executed by selecting these layers and pressing the “Delete” key on the 
keyboard. This will take a couple of minutes.

Step 5: Double click on the “Shapes_Merge” layer to open it. This will display all wards and the 
city/municipal boundary in one layer. 
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Step 6: As explained in the “ICLEI-ACCCRN Tool 3.1”, identify the Climate risks and 
corresponding fragile systems. For example, assume that the city of Barisal has 5 identified 
climate risks and four corresponding fragile systems viz. Water, Sewerage, Transportation and 
Energy. Based on the “number of risks” impacting, these fragile systems will be given scores 
out of 5. For example, if a system within a ward is impacted by all five identified risks, then it’ll be 
given a score of 5 (out of 5). Scores can be entered in Microsoft Excel as shown below.

The title of the first column should be preferably kept as “ID”. Also, the ward names should be 
the same as the ones given while making shapes in Google Earth. After entering all the scores 
and calculating the Average score for all systems (ward-wise), save the file to CSV (Comma 
Separated Values) format so that it can be imported in SAGA GIS later. This can be done by 
selecting “File > Save As” and selecting CSV (Comma Delimited) as the file format.
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Step 7: Now, import the previously saved Scoring Table (attribute table) in SAGA GIS. This can be 
done by selecting “File > Table > Load” and browsing the file location.

Step 8: Attach the “Scoring Table” to the “Shapes_Merge” layer by selecting “Modules 
> Shapes > Tables > Join attributes from a Table (shapes)” and keeping the following 
settings.

This will create a new shape layer with the name “Shapes_Merge [Table File Name]”. To 
check whether the attributes are well attached or not, “Right click on the layer > Attributes > 
Table”. This will open the attribute table. Check if all values are correctly attached or not. If not, 
repeat the step.

Step 9: Open the “Shapes_Merge [Table File Name]” layer and keep the following settings in 
the right hand side panel. 

In the colours section, change the type to “Graduated Colour”. This will change the colour shade 
with score value. (Ex: Low Score = Light Shade, High Score = Dark Shade)

From the same window; select the attribute to be displayed. Example, If Wards having problem 
with water are to be displayed, then select water.

If the Overall Vulnerability of wards is to be displayed then select “Average (overall 
Vulnerability)”.

Set Label as “IDENT”, so that the ward names are displayed (since this column contains ward 
names).

Set the number of colours equal to the “number of identified Climate Risks” from “Graduated 
Colours > Colours > Count = No. of Climate Risks”. This will create Classes equal to number 
of risks in the Map Legend. Ex: If number of risks = 5, then five classes will be created viz. 
0-1, 1-2, 2-3, 3-4, 4-5. Each of these classes will be represented with different colour 
shades on the map.

Colour Ramp (i.e the transition of colour with value) can be selected from “Graduated Colours 
> Colours > Presets”. For better display select bright presets like “White > Red / White > 
Blue / White > Green”.

Click Apply to see the changes on your screen.
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 Click here for Changing 
the Colour Ramp and 
Count.
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Step 10: To export/Print map, click on the blue icon (next to 3D) and then click on the print 
button as shown in the second figure. If you want to print the map, then select the printer from 
which you wish to print. If you want to save the file to your computer go to Step 11.

Step 11: To save the map on your desktop, select your PDF reader as your printer, go to 
properties and customize the settings for High Quality Image. If you don’t see your PDF reader in 
the list of printers, then install a free PDF reader known as “Nitro PDF Reader”.
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Keep the following settings after clicking on “Options”.

Click “OK” and Print. This will prompt you for file Name and Location for saving it. Assign a 
name and location and Click “SAVE”. Below is a sample of an exported map for Barisal (Water). 
Similar maps can be generated for different attributes like Transportation, Energy, Sewerage, 
Overall Vulnerability (Average),etc.

Step 12: After saving maps for all desired attributes, Go to “File > Project > Save Project As”. 
Assign a name and location and Click SAVE. This will pop-out a window asking for the files to 
save. Select “Save All” and Click OKAY. The file will be save in *.spr (SAGA Project) format. To 
open the project, go to “File > Project > Load Project” and browse the file location.
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METHOD B: USING SAGA GIS ONLY

I)   Importing Ward/Base Map in SAGA GIS
Step 1: After downloading SAGA GIS, open the folder where it has been downloaded and double 
click on “saga_gui” (with blue icon). This software requires no installation.
SAGA GIS once started, will display three panels (Left, Middle and Right). The top of the left 
panel consists of three tabs viz. Modules, Data and Maps. Select the “Data” tab. Refer Step 1 of 
III (Method A) for figure.

Step 2: Import the ward map image in SAGA GIS using the “File > Grid > Load” function and 
browsing the file location. While browsing the file location, make sure that the file format is set to 
“All Files”.

Step 3: Once the file is imported in SAGA GIS, a new layer (Grid) will appear in the “Data Panel”. 

Note: If the grid is imported properly, the “Message Panel” will display a message with “Success/Okay” 
at its end (example: Load grid: C:\Users\Kiran\Desktop\ICLEI\Maps\Image00001.jpg...okay). Similarly, 
if the grid is not imported properly, the “Message Panel” will display a message with “Failed” at its end 
(example: Load grid: C:\Users\Kiran\Desktop\ICLEI\Maps\Image00001.jpg...failed).
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Step 4: In case the grid/Image is not successfully imported, 2-3 layers of the same image may 
appear. This is probably because of the software’s multiple attempts to load the grid/Image. In 
such cases, select any of these layers and save it in “*.sgrd” (SAGA GRID) format. This can be 
done by “Right Clicking on Selected Layers > Save As > Assign a name & location”.

After saving the layer in *.sgrd format, Delete the previously imported image/images (Select All 
> Right Click > Close) and Import the recently saved one (File > Grid > Load). 

Please note: that the file format should be set to *.sgrd while importing.
Refer the figure below.

Step 5: Open the imported image by double-clicking on it. If the image is imported in *.sgrd 
format (i.e if Step 4 was performed), change the Colour type to “RGB” and click “Apply”. This 
will display the image in its original form (Colour C)
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II)  Making polygons/Shapefiles (Digitizing)
Step 1: For making polygons/shapefiles, create a shape layer first. This can be done by selecting 
“Modules > Shapes > Construction > Create New Shape Layer” and Keeping the following 
Settings in the pop-up window.

This will add a new layer in the Data Frame.

Step 2: Add the Shape Layer (WARDS) to Ward Map Image. To do this, double click on the shape 
layer (in left panel) and select the Image layer when prompted. Refer to the figure below.
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Step 3: Using the zoom tool (Fig.), zoom to the first ward of your area.

Step 4: Now, select the action tool (Fig), right click on the map and select “Add Shape”.
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Step 5: Using the left click of your mouse, Trace the outline of first ward by clicking repeatedly. 
Zoom in for better accuracy. On completing the trace, press “Enter” and a polygon will appear in 
yellow. 
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Step 6: Open the Attribute Table (Right Click on Wards > Attributes > Show) and Enter the ID 
and Name for the newly digitized/traced polygon. 

For Ward 1, Keep ID as “1” and Name as “Ward 1”. Similarly for Ward 2, Keep ID as “2” and 
Name as “Ward 2” and so on. (This will generate a column “Name” with Ward Names which can 
be later used as a common column for joining the scores table which will in-turn assign scores 
to respective wards/polygons)

Close the Attribute Table  once these fields are filled.

Step 7: Before tracing the next ward, enable Snapping by using the “Snap to” function in the 
right hand side settings panel. Snapping will avoid unwanted gaps between adjacent polygons 
(Wards).
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After clicking “Okay”, Click “Apply” on the right hand side settings panel.

Step 8: Now using the Zoom Tool, Zoom in to the next Ward. Using the Action Tool, right click 
and select “Add Shape” (Ref. Step 4 of II (Method B) for figure). This time, a bubble will appear 
on the top left corner of the middle panel which will indicate that snapping is on. Follow Step 5 
for digitizing the ward & Step 6 for making changed in the attribute table.

Step 9: Follow the same procedure (Step 3, 4, 5 & 6) for all wards within the study region.

Note: Enable snapping before digitizing/tracing every Ward (except for the first ward). 
For this “Steps 7 & 8” can be referred.

Step 8: After digitizing all the wards, double click on the shape layer “Wards” open it as a “New” 
Layer. This will display all digitized wards in a “New Window”.

After clicking on the “Snap to” tab, following window will appear. Add your “Wards” Shape layer 
and Click “Okay”.
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III) Adding attributes/Scores/Data to the Shapefiles and Exporting the Map.
Step 1: Follow Step 6 to Step 8 of III (Method – A) for adding attribute/score table.
Keep the Following settings in Step 8.

This will create a new layer with the name “WARDS [Scoring Table Name]”. 

Step 2: Open the “WARDS [Scoring Table Name]” layer (Double Click) and apply the colour 
settings as discussed in the Step 9 of III (Method A).

Step 3: Follow Steps 10, 11 & 12 of III (Method A) for exporting maps and Saving the Project 
File.
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COMPARISON BETWEEN METHOD A AND METHOD B

METHOD A

Method A Requires three tools/ Software viz. 
Google Earth, DNR Garmin & SAGA GIS.

This method is pretty time consuming due to 
file format conversions.

This method results in creation of too many 
files. However, these files are not heavy.

Since the wards and boundaries are digitized/
traced in Google Earth, Gaps between adjacent 
polygons may appear. However, these are 
noticeable only when the screen is zoomed.

Since this method uses well known and easy 
software like Google earth, it might appear 
user friendly to those who have no experience 
in mapping. 

METHOD B

In Method B, One Software i.e SAGA GIS, does 
all the work

This method consumes relatively less time, 
since no file format conversion is required.

The number of files created in this method is 
less.

Gaps between adjacent polygons can be 
avoided using the “Snap to” function.

SAGA GIS may appear a bit complicated 
for those having no experience in mapping. 
However, it is said to have a very easy interface.
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ESSENTIAL TOOLS – SAGA GIS

Introduction to Saga GIS layout 

When you open SAGA you will see a layout consisting of the following windows: 

Workspace/Left Panel: Is the window where you can, by click through the tabs at the bottom of 
the window, view processing modules, the data you have loaded and the display maps you have 
created from your data. 

Work area/Middle Panel: Is where image maps and other associated data (Attribute Tables, 
Histograms, Plots) are displayed. 

Object Properties/Right Panel: This window displays and allows you to alter information about 
your loaded data and map displays. 

Message Window:  Provides information about processes being run by SAGA.

Important links for SAGA GIS:

SAGA GIS Manual: http://volaya.es/pdf/SagaManual.pdf

Introduction to SAGA Interface: http://www.cdu.edu.au/itl/AII-RS/SAGA_GIS_TUTORIAL_
ENG.pdf



ICLEI ACCCRN PROCESS 159

MAPPING TOOL SUPPORT

REFERENCE
TOOL 4

ICLEI ACCCRN Process

ICLEI ACCCRN PROCESS 159

UNISDR LOCAL GOVERNMENT SELF ASSESSMENT 
TOOL (LGSAT)



ICLEI ACCCRN PROCESS160

REFERENCE TOOL 4

UNISDR LOCAL GOVERNMENT SELF ASSESSMENT TOOL (LGSAT)

1. PURPOSE OF THIS TOOL

A very important part of developing resilience to climate change is to set up systems to deal with 
climate related disasters.  ICLEI works in partnership with the United Nations Office for Disaster 
Risk Reduction (UNISDR) to offer the My city is Getting Ready Campaign.

This campaign was launched in 2010 and there are now more than 1500 cities around the world 
participating. The Campaign provides support for cities to become more disaster ready, including 
a Local Government Self Assessment Tool (LGSAT). This tool can be used as part of the ICLEI-
ACCCRN scoping process in Phase 1, or as an action in your Resilience Strategy.

2. ABOUT THE TOOL

Following is some information taken from Preventionweb.net about the LGSAT and how to 
register to use the tool:

Description

The ‘Local HFA: Local Government Self-Assessment Tool’ is an online tool developed by UNISDR 
and its partners to assist local governments to assess their progress in building resilience to 
disaster. It is part of a series of tools for measuring the progress of nations and communities 
towards meeting the objectives of the Hyogo Framework for Action (HFA), which is the world’s 
universally-accepted guide for reducing disaster risk.

The Local HFA is an important element of UNISDR’s work with local governments. In 2010, 
UNISDR and its partner organizations launched the global campaign Making Cities Resilient – 
“My City is Getting Ready!” The objectives of the campaign are to increase understanding and 
encourage commitment by local and national governments to make disaster risk reduction and 
resilience a policy priority and to bring the global Hyogo Framework closer to local needs.
At the end of each assessment, local governments will have enough information to:

• Map and understand existing gaps and challenges in disaster risk reduction in their locality.

• Enhance understanding among stakeholders in the local community on disaster risk reduction.

• Set a baseline and develop a status report on their progress in fulfilling the Ten Essentials for 
making cities disaster resilient, in the context of the Making Cities Resilient campaign.

• Benefit from interactions with their national government in cases where the national 
government has undergone a similar review using the National HFA Monitor.
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How to sign up to the campaign

The campaign aims to encourage cities and local governments in all countries to sign up to 
the ten essentials and identify activities and plans to improve the city resilience. It first targets 
Mayors / Governors / Commissioners and City Councils in the first instance, whilst also 
addressing technical staff and national authorities responsible for local and urban development 
planning and disaster risk management and reduction.

The term ‘city’ refers to urban areas in general, and the term ‘local government’ includes both 
urban and rural communities of different scales (i.e. regional, provincial, metropolitan, cities, 
towns, municipalities, districts and villages). 

3. FURTHER REFERENCES, LINKS

You can follow these links from the ISDR and “Preventionweb” sites to learn more about the 
Campaign and LGSAT:

http://www.unisdr.org/campaign/resilientcities/

http://www.preventionweb.net/english/hyogo/hfa-monitoring/local/

Your ICLEI office can also assist you to register for the Campaign and the LGSAT, and to 
commence the assessment exercise

“Participating Cities” in the Campaign

All cities and local governments that are interested in participating in the campaign are 
encouraged to sign up on the campaign website using the online application form: 
www.unisdr.org/campaign or by submitting the relevant documents to: isdr-campaign@
un.org. Local governments are requested to fill in the online form or submit the nomination 
form (Annex 2). 

In both cases, a letter from the Mayor’s office addressed to UNISDR shall confirm the 
participation in the campaign, confirming the participation in the campaign and indicating 
which other organizations the city will engage during the campaign. 

Community groups, National Associations of local governments, academia and others can 
initiate the nomination process through contacting the Mayor´s office.

By signing up online and sending the mayor´s letter or by sending the nomination form 
and the mayor’s letter to UNISDR, the local government automatically participates in the 
campaign and will be added to the web-based campaign city map. After signing up the local 
government can create its own online profile on the campaign website.

A campaign certificate that will be either sent virtually or given in a signing ceremony will 
complete the sign-up process.

UNISDR encourages the Mayor’s office to seek the approval of the City Council to be 
officially involved as a “participating city” in the campaign. The local government shall 
inform the central government about the participation and notify the official Hyogo 
Framework for Action focal point or the National Platform for Disaster Risk Reduction 
(contact information can be requested from UNISDR secretariat.)
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1. PURPOSE OF THIS TOOL

There are many cities around the world that have started to take climate action similar to the ICLEI ACCCRN 
process you have commenced.  In addition to working at the local level, your city can join an international 
movement of cities tackling climate change.  One way of doing this is to join ICLEI.  Another is to sign the 
Durban Adaptation Charter so that your city makes public its commitment to climate resilience.

2. ABOUT THE TOOL

The Durban Adaptation Charter was launched at the United Nations Framework Convention on Climate 
Change (UNFCCC) Conference of the Parties (COP) 17 held in the City of Durban (eThekwini Municipality), 
South Africa in December 2011. 

The South African Government, through the South African Local Government Association (SALGA), South 
African Cities Network (SACN), eThekwini Municipality and the Department of Environmental Affairs 
partnered with ICLEI - Local Governments for Sustainability in hosting the Durban Local Government 
Convention: adapting to a changing climate - towards COP17/CMP7 and beyond.

The initial signing of the Durban Adaptation Charter by 114 signatories, representing 950 local governments 
organisations from 27 countries builds on the recognition of local governments as government stakeholders 
in the Cancun Agreement.

By going through the ICLEI ACCCRN Process your city government has started taking action towards making 
your city more climate resilient. The signing of the Durban Adaptation Charter will enable your city to reach 
out to a larger audience and showcase its commitment and actions for climate resilience on an international 
platform. 

The Commitment

By committing to the Durban Adaptation Charter, your city will demonstrate its political will to address climate 
change, pledging to enhance its local adaptive capacity, mainstreaming adaptation in local government 
planning, and instigate greater resilience to climate change.  

The Durban Adaptation Charter commits Local Governments to local climate action in their jurisdiction that 
will assist their communities to respond to and cope with climate change risks thereby reducing vulnerability. 
By signing the Durban Adaptation Charter they commit to inter alia:

1. Key information of all local government development planning;
2. Ensuring that adaptation strategies are aligned with mitigation strategies;
3. Promoting the use of adaptation that recognizes the needs of vulnerable communities and ensuring 
sustainable local economic development;
4. Prioritizing the role of functioning ecosystems as core municipal green infrastructure;
5. Seeking innovative funding mechanisms.

How to sign the Charter

In order to sign the charter your local government or association of local governments can visit the web link 
for the charter at following address:
http://www.durbanadaptationcharter.org/

3. FURTHER RESOURCES, LINKS

The Durban Adaptation Charter, http://www.durbanadaptationcharter.org 
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ABOUT THE REGISTRY

The carbonn Climate Registry (cCR) is a global mechanism that encourages local governments 
to regularly and publicly report on their greenhouse gas reduction commitments, GHG 
emissions inventories and climate mitigation/adaptation actions. The cCR was developed by local 
governments for local governments. 

The cCR enables cities and local governments to publicly register their greenhouse gas 
reduction commitments, report performance and showcase actions.

The cCR ensures that local climate action is measurable, reportable and verifiable, and that 
data are consistent with the standards of the global climate regime.

The cCR supports the global credibility of local climate action and ensures transparency, 
accountability and comparability.

Why register local climate data with the cCR?
• To promote local climate action the world can count on. 

• Local governments are taking a lead role in global climate protection and have already driven, 
mirrored and supported national and international climate processes.

• The cCR supports the global credibility of local climate action by ensuring comparability, 
transparency and accountability.

• Local Governments involved in the process will have continuous support in capacity and 
knowledge development through the services of the Bonn Center for Local Climate Action and 
Reporting – carbonn®.

For more information on the registry and how to join, please see:
http://carbonn.org/ 
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This part of the ICLEI ACCCRN Process is based on the Urban Climate Resilience Planning 
Framework (UCRPF) developed as part of the ACCCRN program. The framework is outlined in 
detail in the paper “Catalyzing Urban Climate Resilience” (ISET, Rockefeller Foundation, July 
2011, www.i-s-e-t.org)

Some key elements of this framework as stated in the ISET publication are:

The framework is intended to be a tool to help simplify and analyse complex relationships 
between urban residents, urban systems, urban institutions, and climate change.  It can help 
clarify the factors that need to be included in diagnosis of climate vulnerability and refine the 
process of strategic planning to build urban resilience to climate change (pp 7). 

By focusing on urban systems (the foundation on which urban areas survive), urban agents (the 
diverse organizations that make up the urban social environment), urban institutions (the rights, 
laws, regulations, and other social structures that mediate relationships among agents and 
between agents and systems), and the impact of climate change, the UCRPF helps to identify 
specifically who might do what to build climate resilience (pp 3).

Within the framework, building resilience means identifying and ameliorating fragile systems 
through strengthening those characteristics that reduce their vulnerability to climate impacts.  It 
also means strengthening the capacities of social agents to access urban systems and to develop 
adaptive responses.  Finally, building resilience means addressing the institutional factors that 
constrain effective responses to system fragility or undermine the ability to build agent capacity 
(pp 101).

The three key components of the Urban Climate Resilience Planning Framework are:
(i) Urban Systems; (ii) Agents; and (iii) Institutions. 

Urban systems: 
Include ecosystems and infrastructure systems along with the knowledge required to manage, 
maintain, and develop them (pp 37)

Actors (Agents): 	
Include individuals (e.g., farmers, consumers); households (as units for consumption, social 
reproduction, education, and capital accumulation); and private and public sector organizations 
(government departments or bureaus, private firms, civil society organizations). They have 
identifiable but differentiated interests and are able to change behavior based on experience and 
learning (pp 45)

Rules and Practices (Institutions):
The rights, laws, regulations, and other social structures that mediate (Institutions)		
relationships among agents [Actors] and between agents [Actors] and systems (pp 3)

1Please note that the text and page references are based on an early draft version of the UCRPF and may be different in the 
final version of the document.
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The diagram below indicates the inter-relationship between these three components and the 
process in which it contributes towards building climate resilience. The interactions between the 
urban systems, actors, and rules and practices (represented by symbols in the left circle) help 
understand the vulnerabilities of the city which would feed into the process of building resilience 
(the circle on the right). Further, as depicted in the diagram, the process of ‘shared learning’ is 
the binding element between these other two processes.

Represents ‘Urban Systems’

Represents ‘Actors’

Represents ‘Rules and Practices’

Represents Climate Exposure

Source: ISET, 2011
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Please view both pages as the same table.

Consequence Rating

Local Economy and GrowthPublic Safety

Success Criteria

Catastrophic

Major

Moderate

Minor

Insignificant

Regional decline leading to widespread 
business failure, loss of employment and 
hardship

Regional stagnation such that businesses 
are unable to thrive and employment does 
not keep pace with population growth

Significant general reduction in economic 
performance relative to current forecasts

Individually significant but isolated areas 
of reduction in economic performance 
relative to current forecasts

Minor shortfall relative to current 
forecasts

Large numbers of serious injuries or 
loss of lives

Isolated instances of serious injuries 
or loss of lives

Small number of injuries

Serious near misses or minor 
injuries

Appearance of a threat but no actual 
harm
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Community and Lifestyle Public Administration

Success Criteria

Environment and Sustainability

The region would be seen as very 
unattractive, moribund and unable to 
support its community

Severe and widespread decline in 
services and quality of life within the 
community

General appreciable decline in 
services

Isolated but noticeable examples of 
decline in services

There would be minor areas in which 
the region was unable to maintain its 
current services

Public administration would fall into 
decay and cease to be effective

Severe loss of environmental amenity 
and a danger of continuing environmental 
damage	 Public administration would 
struggle to remain effective and would be 
seen to be in danger of falling completely

Public administration would be under 
severe pressure on several fronts

Isolated instances of public administration 
being under severe pressure

There would be minor areas of public 
administration being under more than 
usual stress but it could be managed

Major widespread loss of 
environmental amenity and 
progressive irrecoverable 
environmental damage

Severe loss of environmental 
amenity and a danger of continuing 
environmental damage

Isolated but significant instances of 
environmental damage that might be 
reversed with intensive efforts

Minor instances of environmental 
damage that could be reversed

No environmental damage

Source: Commonwealth of Australia (2006): Climate Change Impacts and Risk Management – A Guide for Business and Government
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MENU OF CLIMATE ADAPTATION ACTIONS

1. PURPOSE OF THIS TOOL

Research into case studies and best practice from other areas can provide a rich source of 
possible actions, or interventions.  This tool provides some lists of possible actions and resources 
which cities can use for their own research.

2. ABOUT THE TOOL

Following is a selection of actions which have been taken by cities to adapt to climate change.  
However, every city is unique and care should be taken to ensure that chosen actions are 
appropriate for local conditions and will be understood and “owned” by local stakeholders.

IPCCC
The 2007 Climate Change Synthesis Report, Chapter 4, Adaptation and Mitigation Options, gives 
a selection of possible adaptation actions by sector, along with policy considerations, constraints 
and opportunities:

Sector Underlying policy
framework 

Adaptation option/
strategy 

Key constraints and 
opportunities to
implementation

(Normal font = constraints; 
italics = opportunities) 

Water

Agriculture

Infrastructure/settlement 
(including coastal zones)  

National water policies 
and integrated water 
resources management; 
water-related hazards 
management 

R&D policies; institutional 
reform; land tenure and 
land reform; training; 
capacity building; crop 
insurance; financial 
incentives, e.g. subsidies 
and tax credits  

Standards and regulations 
that integrate climate 
change considerations into 
design; land-use policies; 
building codes; insurance 

Expanded rainwater 
harvesting; water 
storage and conservation 
techniques; water re-use; 
desalination; water-use and 
irrigation efficiency 

Adjustment of planting 
dates and crop variety; crop 
relocation; improved land 
management, e.g. erosion 
control and soil protection 
through tree planting 

Relocation; seawalls and 
storm surge barriers; 
dune reinforcement; land 
acquisition and creation of 
marshlands/wetlands as 
buffer against sea level rise 
and flooding; protection of 
existing natural barriers 

Financial, human resources 
and physical barriers; 
integrated water resources 
management; synergies with 
other sectors  

Technological and financial 
constraints; access to new 
varieties; markets; longer 
growing season in higher 
latitudes; revenues from ‘new’ 
products  

Financial and technological 
barriers; availability of 
relocation space; integrated 
policies and management; 
synergies with sustainable 
development goals  

Table continued on the next page
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3. FURTHER RESOURCES, LINKS

There are many other useful resources and lists of actions available on the internet, including:

ICLEI Case Studies	

ICLEI has compiled more than 165 case studies from many countries showing how cities 
are adapting to climate change and becoming more energy efficient.  The ICLEI Case Study 
series highlights the role of ICLEI Members and other local governments as key drivers and 
implementers of urban sustainable development across the globe by illustrating successful 
approaches, innovative models and transferable best practices in the field of urban development 
and sustainable projects. 

In general the case studies are maximum 8 pages and include the following standard headings:
• the local context of the project
• the anatomy of the project
• results
• lessons learned
• the project’s replication potential
• budgeting and financial issues

The ICLEI case studies series is available at no charge and can be accessed at:
www.iclei.org/casestudies

Catalyzing Urban Climate Resilience, ISET
Chapter 7 of this publication, already introduced in Reference Tool 1.2, gives examples of City 
Resilience Strategies from the four original ACCCRN countries – India, Indonesia, Vietnam and 
Thailand. The publication can be found on the ISET website at
www.i-s-e-t.org

World Bank
Carmin& Zhang, 2009 Achieving Urban Climate Adaptation in Europe and Central Asia (World 
Bank Paper)

UN Habitat
Planning for Climate Change, A Strategic, Values-Based Approach for Urban Planners, P.112
Planning for Climate Change
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Sector Underlying policy
framework 

Adaptation option/
strategy 

Key constraints and 
opportunities to
implementation

(Normal font = constraints; 
italics = opportunities) 

Human Health

Transport

Energy

Tourism

Public health policies 
that recognise climate 
risk; strengthened health 
services; regional and 
international cooperation 

Integrating climate change 
considerations into national 
transport policy; investment 
in R&D for special 
situations, e.g. permafrost 
areas

National energy policies, 
regulations, and fiscal 
and financial incentives 
to encourage use of 
alternative sources; 
incorporating climate 
change in design standards 

Integrated planning (e.g. 
carrying capacity; linkages 
with other sectors); 
financial incentives, e.g. 
subsidies and tax credits  

Heat-health action plans; 
emergency medical 
services; improved 
climate-sensitive disease 
surveillance and control; 
safe water and improved 
sanitation  

Realignment/relocation; 
design standards and 
planning for roads, rail and 
other infrastructure to cope 
with warming and drainage 

Strengthening of overhead 
transmission and 
distribution infrastructure; 
underground cabling for 
utilities; energy efficiency; 
use of renewable sources; 
reduced dependence on 
single sources of energy 

Diversification of tourism 
attractions and revenues; 
shifting ski slopes to higher 
altitudes and glaciers; 
artificial snow-making    

Limits to human tolerance 
(vulnerable groups); 
knowledge limitations; 
financial capacity; upgraded 
health services; improved 
quality of life 

Financial and technological 
barriers; availability of less 
vulnerable routes; improved 
technologies and integration 
with key sectors (e.g. energy) 

Access to viable 
alternatives; financial and 
technological barriers; 
acceptance of new 
technologies; stimulation of 
new technologies; use of local 
resources  

Appeal/marketing of new 
attractions; financial and 
logistical challenges; 
potential adverse impact on 
other sectors (e.g. artificial 
snow-making may increase 
energy use); revenues from 
‘new’ attractions; involvement 
of wider group of stakeholders  

http://www.ipcc.ch/publications_and_data/ar4/syr/en/spms4.html
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ACCCRN projects catalogue

The Asian Cities Climate Change Resilience Network (ACCCRN), from which the ICLEI-ACCCRN 
toolkit was developed, has documented climate adaptation actions, or “projects”, initiated by the 
original ten ACCCRN cities, in a Project Catalogue. This gives a 2-page summary of each city 
project. Following is the list of projects from the May 2013 edition:

INDIA
Gorakhpur: Implementing and Promoting Ward-level Micro Resilience Planning
Gorakhpur: Implementing and Promoting Adaptive Peri-urban Agriculture
Indore: Testing and Promoting Decentralized Systems for Differential Water Sources and Uses
Indore: Strengthening Vector-borne Disease Surveillance and Response Systems
Indore: Peri-urban Lake Restoration to Create Emergency Water Management Options
Indore & Surat: Promoting Cool Roof and Passive Ventilation for Indoor Temperature Comfort
Surat: End-to-end Early Warning System
Surat: Urban Health and Climate Resilience Center

INDONESIA
Bandar Lampung: Integrated Solid Waste Management Master Plan
Bandar Lampung: Ground Water Conservation (Biopores)
Bandar Lampung: Building Teachers and Students Climate Change Resilience Capacity
Semarang: Pre-feasibility Study for Expanding Rainwater Harvesting Systems
Semarang: Flood Forecasting and Warning System
Semarang: Actions Changing the Incidence of Vector-Borne Endemic Diseases (ACTIVED)
Semarang: Enhancing Coastal Community Resilience through Strengthened Mangrove 
Ecosystem Services and alternative livelihoods

THAILAND
Chiang Rai: Restoration of Kok River for Urban Flood Management
Chiang Rai: Developing Climate-Resilient Urban and Economic Development Plans 
Hat Yai: Community-based Flood Preparedness and Institutional Coordination Systems
Hat Yai: Building Long-Term Resilience to Flood Impacts though Climate-Informed Flood Plans 

VIETNAM
Can Tho, Da Nang, QuyNhon: Climate Change Resilience Coordination Offices (CCCOs)
Can Tho, Da Nang, QuyNhon: Vietnam Youth Urban Resilience Competition
Can Tho: Strengthening Dengue Fever Surveillance and Response System
CanTho: Developing and Implementing Real-time Salinity Monitoring, Dissemination and 
Response Mechanisms
Can Tho: Community-Based Canal and Riverbank Strengthening
Da Nang: Hydrology, Hydraulic and Urban Development Simulation Model
Da Nang: Storm and Flood Resistant Credit and Housing Scheme
Da Nang: Developing, Testing and Promoting New Education Modules to Increase Youth 
Awareness on UCCR
Da Nang: Pathways to Water Resilience: A Comprehensive Assessment
QuyNhon: Hydrology and Urban Development Modeling for Flood-related Land-use Planning
QuyNhon: Urban Mangrove Restoration for Storm Surge Protection and Resilient Land-use 
Practice
QuyNhon: Developing Real-Time Flood Monitoring and Community Flood Communications and 
Response System in the Lower Ha Thanh and Kon Rivers

http://www.acccrn.org/resources/documents-and-tools
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An example of the outcome of a modelling exercise, focussing on achieving greater resilience to heatwave 
conditions.

REFERENCE TOOL 10



ICLEI ACCCRN PROCESS 179

INTERVENTION MAPPING

There are many ways of constructing conceptual models.
We are suggesting developing one that is based on the following different model elements - an approach that 
in our experience has proven suitable to conceptual modelling for climate change adaptation.
A target condition is a vision, a state that City wants to be at in relation to a particular climate change impact.
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Important that this step focuses on City functions – over which the City has reasonable control and can there-
fore effect change.
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INTERVENTION MAPPING

Direct factors are all those processes, events and activities that directly and immediately affect each of the 
components – no matter whether they are under the direct influence of City or not.

Direct factors, then again, are influenced and defined by a range of issues, such as particular legislation, the legacy of particular historic 
events or specific processes of organisational reform, for example. You can see that you could theoretically subdivide the model further 
and further. This is up to the user to decide – where it makes sense to go into more detail and where it doesn’t.
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Conditions are general influences that are not directly connected to Factors or Components, but that still 
influence the system on the whole, at various points. In this case, a large proportion of elderly population is the 
condition.
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The cards are then assembled to produce a map of possible interventions.

INTERVENTION MAPPING



ACKNOWLEDGEMENTS
ICLEI ACCCRN Process

The publication has been produced with the financial support of the Rockefeller Foundation 
under its Asian Cities Climate Change Resilience Network program. It draws on a similar toolkit 
developed by ICLEI Oceania for Australian local governments as well as from other ICLEI offices.  
Critical inputs from ARUP, the Institute for Social and Environmental Transition-International 
(ISET - International), and other ACCCRN partners are gratefully acknowledged. The ICLEI team 
wishes to thank Anna Brown, Rockefeller Foundation, for her thorough revision of the document.



Contact
ICLEI South Asia

NSIC Bhawan
Okhla Industrial Estate

New Delhi - 110020, India

iclei-southasia@iclei.org
http://southasia.iclei.org/



ICLEI
ACCCRN

BUILDING URBAN CLIMATE CHANGE RESILIENCE:
A TOOLKIT FOR LOCAL GOVERNMENTS


